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Notice 
We make every effort to provide the latest 
technical documentation. There may be 
updates. For this, please contact 
subsea_support@NORBIT.com for the latest 
information. 
 

Copyright Statement 
Copyright 2017 by NORBIT. All rights 
reserved. This publication may not be copied, 
translated, reproduced or transmitted in any 
electronic form, without prior written consent 
from NORBIT. 
 

Disclaimer 
While every effort is made to ensure the 
information given is accurate, NORBIT does 
not accept liability for any errors or omissions. 
All non-metric weights and measurements are 
approximate. Specifications, equipment, and 
other information in this document are subject 
to change without notice. 
 
All performance metrics mentioned in this 
document, such as attainable depths, was 
derived from tests in Portland, Oregon and 
Seattle/Tacoma, Washington, USA in May 
2017. Acoustic conditions are described when 
describing performance capabilities. 
 

Sonar Kits 
This manual covers the following NORBIT 
products: 
 
WBMS  12003 
iWBMSe  12006 
iWBMSc  12005 
iWBMS/STX 12004 
iWBMSh/STX 12007 
 

Release Notice 
This is the April 17, 2020 release of the 
NORBIT WBMS user and technical manual. 
 

 

 Contact Information 
NORBIT Subsea AS 
Stiklestadveien 1 
7041 Trondheim 
Norway 
 
Phone: +47 739 82 569 
Email: subsea_support@NORBIT.com 
Web: http://www.NORBIT.com 
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 Introduction 

1.1 Terms & Abbreviations 

 

AMPS Amperes 
Aux Auxiliary 
Bandwidth Range of frequency sweep 
CW Continuous Wave (single frequency) 
EA Equal Angle beam distribution 
ED Equal Distance beam distribution 
FM Frequency Modulation (swept frequency) 
GAMS GNSS Azimuth Measurement Subsystem 
GNSS Global Navigation Satellite System 
GPS US Global Positioning Satellites (often describes all GNSS) 
GUI 
HAW 

Graphical User Interface 
Heading Alignment Wizard 

IHO International Hydrographic Organization 
IMU  Inertial Motion Unit 
INS 
iSIUc 

Inertial Navigation System 
SIU - Compact 

iSIU Integrated SIU 
iWBMSe Integrated WBMS – Entry Level (SurfMaster) 
iWBMSc Integrated WBMS – Compact (pre-mid-grade with STIM300) 
iWBMS Integrated WBMS – Standard (mid-grade with WaveMaster) 
iWBMSh Integrated WBMS – Pro (with top level OceanMaster) 
LED  Light Emitting Diode 
MBES Multibeam Echosounder Sonar 
NTP Network Time Protocol 
POS 
PPK 

Positioning & Orientation System 
Post Processed Kinematic 

PPS Pulse Per Second 
PTP Precise Time Protocol 
RTK Real Time Kinematic 
Rx Receive 
SBAS Satellite Based Augmentation System 
SIU Sonar Interface Unit 
SNR Signal to Noise Ratio 
SONAR Sound Navigation and Ranging 
SOSP 
SPAN 
STX 

Speed of Sound Profile 
Synchronized Position Attitude Navigation 
Steerable Transmission  

Tx Transmit 
USACE USA Army Corps of Engineers 
VDC Volts – Direct Current 
WBMS Wideband Multibeam System 
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1.2 Technical Overview 

The NORBIT Wide Band Multibeam Sonar (WBMS) is the most compact, high resolution, wide swath 
multibeam sonar available. With a dry-weight of less than 4.5kg (10lbs), beam widths of only 0.9° at 
400kHz, and low power consumption, the stand-alone multibeam sonar easily mounts to a survey 
platform of any size and may be powered by a small battery (e.g. laptop extension battery pack) or 
standard AC plug. 
 
The WBMS is optimized to transmit a frequency modulated (FM) sound wave centered at either 
200kHz (for deep waters) or 400kHz. From the returning signal, 256 or 512 beams are formed within 
a user-selectable 5° to 210° fan-shaped swath, utilizing the integrated sound speed probe. The 
curved receiver arrays of the NORBIT systems allow for narrow beams over a wide swath with 
significantly reduced beam spreading compared to flat arrays. The curved array allows for a more 
forgiving sonar in areas of surface sound speed variations. NORBIT has implemented cutting edge 
signal gain compensation, adaptive gating/thresholding, and proprietary amplitude and phase 
detection algorithms to achieve accurate and repeatable bottom detections.   
 
For projects requiring maximum sounding coverage, NORBIT has developed a steerable 
transmission sonar called the STX. The STX can sweep through a 20° along-track sector in scanning 
mode, providing a 3D scan of the environment. The STX can be operated as a forward-looking sonar 
or as a conventional multibeam, making this one of the most versatile systems developed by 
NORBIT. The STX is ideal for complex surveys where coverage gaps must be minimal, structural 
detections must be accurate and the survey 
completed in as little time as possible.  
 
All processing and export of time-stamped bottom 
detection occurs within the sonar head. The system 
requires very little user intervention to achieve clean 
and repeatable bathymetry. Hardware installation is 
similarly very easy and quick. A single cable powers 
and connects the sonar to a small Sonar Interface Unit 
(SIU). The SIU similarly connects to a data 
acquisition/sonar control PC by a single ethernet 
cable.  
 
The NORBIT WBMS is unique to the industry as the 
first platform designed as a cylindrical array wideband 
system with frequency modulated (FM) transmission 
signals. With latest FPGA circuits, integrated surface 
sound speed probe, and 21st century engineering, the system provides the resolution and 
capabilities of much bulkier systems. Efficiency savings begin with installation: the compact (and 
lightweight) form-factor enables for simpler, less robust, mounting infrastructure than earlier 
generation box-shaped multibeam sonar systems. Low power requirements allow added flexibility 
on very small survey vessels as well as any vessel of opportunity. 
 
NORBIT offers many options for a tightly integrated bathymetric mapping solution that combines all 
sensors required to carry-out high-grade bathymetric surveys. The integrated system, with a 
complete GNSS/INS system, drastically streamlines the setup process and reduces measurement 
uncertainties. NORBIT offers a range of integrated systems and peripherals to suit varying survey 
demands and budgets. 
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1.3 Advantages of the Cylindrical Array 

The WBMS broke the industry mold by bringing a low cost and compact yet highly accurate 
cylindrical receiver array with highest signal bandwidth to the market. Below are some of the 
advantages a cylindrical array offers. 
 

• Unlike a flat array, bottom detections from a cylindrical array are much less susceptible to 
surface sound speed errors. 

 

• The WBMS does not begin to beam steer until ± 30° from nadir. This results in lower incidence 
of depth error from the reduced beam width spreading as steering increases (flat receiver arrays 
steer all beams but nadir). 

 

• At all frequencies, the WBMS provides increased swath coverage with a smaller beam footprint 
for a fixed aperture.    

 

• The cylindrical array of the WBMS can cover a full 210°. Flat array systems would lose data 
fidelity at much lower swath angles (± 80°) and would necessitate mounting two or three sonars 
at angles to achieve higher swath coverage.  

 

• The cylindrical array presents a more hydrodynamic profile allowing for faster transit, less 
vibration, and use of lighter mounting hardware. Sturdier mounting, such as hull mounts, enables 
a maximum transit speed of >20 knots.  

1.4 Advantages of the INS Integrated System 

Factory integration of critical sensors yields a forgiving acquisition experience for the onboard 
surveyor. Offsets between sonar measurement reference and inertial motion unit reference centers 
are fixed and predefined within the system setup. The user need only measure from top center of 
sonar bracket to bottom of primary antenna mount. 
 
Cabling and software integration between sonar, positioning, heading, attitude and sound speed 
probe is handled internally. The onboard surveyor need only connect the wet end to the topside via 
a single cable and then connect the primary and secondary GNSS cables (which are each labelled 
on both ends of the cable to remove installation uncertainty).   

1.5 How to Use this Manual 

This manual describes the complete installation and operation of all the NORBIT bathymetric Wide 
Band Multibeam Systems (WBMS). This may be the WBMS, iWBMSe, iWBMSc, iWBMS, iWBMSh 
or any of these in dual head configuration. 
 
The reader is strongly encouraged to read this manual thoroughly. Doing so will encourage safe and 
efficient operation in the collection of high quality beamformed bottom detections. 
 
NORBIT makes every effort to ensure that the information contained in this manual is accurate and 
fully updated to correspond with the latest sonar firmware and software releases. The sonar firmware 
version being employed must correspond with the version listed at the bottom of each page in this 
manual. 
 
This manual is optimized for digital viewing using PDF viewing software. If a suitable browser is not 
available then any web GUI (Firefox, Chrome, etc.) would work. The table of contents section will 
link directly to each section listed. At the bottom of each page is a link to return to Table of Contents. 
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1.6 System Specifications  

While continual improvements are being implemented, specifications may change. To obtain the 
most current specification sheets please visit https://www.NORBIT.com/subsea/ 

1.7 Export, Shipping Weight & Dimensions 

The compact size of the WBMS systems allows for simplified shipping and handling. The lightest 
NORBIT system wet-end is the 0.9° x 1.9º WBMS at 4.5kg in air while the heaviest system is the 
0.9° x 0.95º iWBMSh which has an integrated IMU and provides the highest resolution data and is 
11kg in air and 7kg in water. 

 ITAR Restrictions 

Except for the iWBMSc, all others in the iWBMS(x) family contain an Applanix POS MV. All systems 
are free of Canadian and EU export controls.  

 
When exported from the U.S., the U.S. Department of Commerce ECCN 7A994 reference number 
needs to be quoted on all shipping documentation. 
 
 

⚠ 
 

CAUTION:  For US-Based Systems 

For shipping internationally, all shipping documents should quote ECCN 
7A994. This number is the same for all Applanix & NovAtel systems.  
NORBIT strongly recommends DHL as a preferred shipper when shipping 
internationally. 

 
 
Due to system configuration and selected components, there are no import or export restrictions on 
the WBMS sonar which facilitates unimpeded global operations.  

 Shipping  

Each NORBIT system (including all components) are shipped in a single, lightweight Pelican case 
that meets airline baggage guidelines.  
 
Airline Checked Luggage: Despite the rugged freight case construction with dense form-cut foam 
shock absorption, it is prudent to handle the full cases with care. Please ensure an airline “Fragile” 
label is prominently displayed. 
  
Airline Carry-On Baggage: The WBMS case may be hand-carried onto many airplanes but when 
checking through airport security it is often required to remove the sonar from the case for x-ray. 

1.8 Caring for Your Investment 

To protect the sonar from undue damage, please follow these reasonable minimum guidelines, 
especially while operating in harsh environments. 
 
Never support the WBMS by the sound speed probe or strictly by the projector. For the stand-alone 
WBMS when shipping in a non-foam cut case, remove the sound speed probe and replace it with 
blue dust cap. Ensure all connectors are protected with provided caps/covers when not in use. 
 

https://www.norbit.com/subsea/
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For the integrated versions, especially the larger iWBMSh 1°, take extra precaution against drops or 
rough handling, especially when shipping via courier. Use “Fragile” labels where/when possible to 
add further protection for the system suite. 

 
Replace connector caps on sonar, SIU and cables when not in use to keep out debris and moisture. 
Choose a dry location at room temperature for prolonged storage. Never wet store system in sealed 
environment; dry the system before returning to the case. When returning to office, open the case. 
 
 

⚠ 
 

CAUTION:  Sonar Protection 

When submerged for long periods, the sonar is at risk of becoming fouled by 
barnacles etc. (especially in warm salty water) or may be subjected to stray 
electric currents. NORBIT offers both titanium housing, additional anodes 
and factory applied bio-fouling paint that is approved and tested against 
acoustical losses. Contact subsea_support@NORBIT.com for info. 

 
Do not leave system in the sun for long durations. Prolonged exposure to UV rays may cause 
degradation of the polyurethane coating on the transducers; potential damage includes drying and 
crack formation which would permanently expose and damage sensitive sonar electronics. 
 
Never allow wet end to rest on the polyurethane as this may scratch or wear this sensitive area.  
Always use a sturdy padding (foam) under the sonar when mounting it. 
 
To clean the WBMS, only use mild, nonabrasive soap, fresh water, and a soft brush to gently scrub 
the sonar. Using any other method may damage the sonar. Do not use a power washer to clean the 
sonar. This can damage the housing and cause the sonar to improperly beam form. 
 
To protect the system from corrosion, take extra care when handling to not scratch the anodized 
aluminum housing (not a concern for titanium housing). It is also a good practice to rinse off the 
sonar after use, especially if used in saltwater, and allow it to dry completely prior 
to storage. As an added layer of corrosion protection, it is recommended that the 
vessel anodes be checked on a regular basis. This will further protect the WBMS. 
 
If the WBMS is hull mounted, NORBIT provides an option for performance neutral 
antifouling paint application. Painting of the sonar outside of NORBIT may cause 
negative impacts to system performance and pushes the system outside of 
warranty.  
 
If the sonar will be in the water for extended periods, it is recommended that 
sacrificial anodes be used to protect against electrolysis. Anodes can be collared 
around the cable connection and the inserted into the receiver frame, as shown in the adjacent 
images. Care must be taken to not scratch the anodizing on the aluminum housing during 
installation. Spare anodes can be purchased directly from NORBIT. 
 
NORBIT offers antifouling paint service. If your system is protected with antifouling paint then 
additional care is required to ensure the paint is not scraped or rubbed off during mobilization, 
shipping or handling. After retrieving the sonar from the water wipe down the system with a clean 
towel to clear off dirt, grime, marine growth, etc. that may otherwise compromise the sonar body. 
 
 

⚠ 

CAUTION:  Do Not Connect/Disconnect Cables with Power On 

To prevent damage to system electronics always turn off power before 
disconnecting or swapping cables. 
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1.9 Maintenance Schedule 

It is good practice to perform periodic inspections or checks of the sonar system. The table below 
lists several checks, recommended by NORBIT, to guide users in performing maintenance checks. 

 Before Each Survey 

Component Inspection Additional Notes 

Receiver 
Array 

Inspect polyurethane for gouges, nicks or 
separation from housing. The array face 
should be smooth and uniform. 

Water intrusion will result in excessive 
damage and be costly to repair. Contact 
NORBIT Support for further information. 
Always store sonar away from sun. 

Projector 
Array 

Inspect the projector array for gouges or nicks 
and check the attachment area of the projector 
with the sonar housing. The projector surface 
should be smooth and uniform. A delamination 
protection ring should be tightly fitted to 
projector at the housing attachment point. 

Water intrusion will result in excessive 
damage and be costly to repair. Contact 
NORBIT Support for further information. 
Always store sonar away from sun. 

O-Rings on 
wet end 
cable 
connections 

Check O-rings for damage and particulates 
that may interfere with O-ring operation and 
keep it lightly lubricated. Use Silicone Grease 
that is min 90% pure. 

If missing a spare O-ring, please remove 
and borrow one from the cable wet-end 
protective cap. But be sure to get the 
appropriate one replaced from NORBIT 
support. 

Sound 
Speed 
Probe 

Remove sound speed probe and check 
connector for corrosion. Probe O-ring should 
be in good condition. Replace probe and 
ensure a tight fit. Apply light coating of silicone 
grease to O-ring prior to re-attaching probe. 
Compare value with value from profiler at 
same depth. Difference should not be greater 
than 1m/s 

Bad or missing surface sound speed will 
create beam steering errors and affect 
outer swath data performance. It is 
recommended that the probe be 
calibrated every 18-24 months.   

Sonar 
Housing 

Inspect housing for scratches and corrosion.  
Ensure anode is in good condition (for 
aluminum housing).   

Small scratches compromise the galvanic 
barrier of the aluminum housing. Contact 
NORBIT for further information. 

Sonar Cable 
Connector 

Check for debris and clean out with 
compressed air. Cable connector must be dry 
and clean. Use protective cap when not in-use. 

Sonar connection is not wet-mateable. 
Do not disconnect or connect when sonar 
is submerged or in wet areas. 

Sonar Cable Check connectors and clean out with 
compressed air. Run cable through hand and 
check that cable is smooth, without kinks and 
without tears. Check that pins are shiny and 
not bent. Check O-rings for wear and replace 
as necessary. Use small amount of silicone 
lubricant. 

A bad connection or bad cable will 
corrupt survey data. Treat the cable with 
great care (do not walk on it). 

Sonar 
Mounting 
Bolts 

Check that threads on plastic sleeves are in-
tack and not de-threaded. Vibration over long 
term can loosen bolts and compromise data 
quality or loss of wet-end. 

Use only stainless-steel bolts and 
washers. Contact NORBIT for spare 
parts. Use Loctite 242 Blue, lock washers 
and/or nylon nuts. 

Mounting 
Bracket 

Check that all hardware for the mounting 
bracket is tight. Care must be taken when 
checking the mounting screws for the sonar as 
over tightening may damage the connections 

The bracket is very robust and provides 
electrical isolation from the vessel. 

Electrical & 
Galvanic 
Isolation 
Shield  

Check that plate is included in shipping case 
and used between sonar and sonar bracket 
when mounted. For the WBMS (non-integrated 
systems), it is imperative to use the included 
electrical isolation shield. 

This protects the aluminum sonar 
housing from galvanic corrosion. 
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WBMS 
Firmware & 
GUI 
Versions 

Ensure that both firmware and GUI versions 
match and are latest. 

Prior to each new survey. Contact 
NORBIT support for details. 

Integrated 
INS 
Firmware & 
GUI Version 

Ensure that both firmware and GUI versions 
match and are latest. This may require an 
annual maintenance cost. 

Prior to each new survey. At least once 
each year. Contact NORBIT support for 
details. 

 After Each Survey 

Component Inspection Additional Notes 

Complete Kit Perform all inspections in the previous section.  Ensures that users are ready 
for the next survey. 

Wet-End The complete wet end should be rinsed with fresh 
water. Clean off any marine growth with soft rag. If 
barnacles have taken refuge on the sonar, then 
remove these very carefully so as not to pit or nick the 
polyurethane. If any damage occurs to the anodized 
aluminum or polyurethane, then take a high-resolution 
picture and send to NORBIT support for help. 
Allow the kit to dry before locking down the lid. Once 
back at the office, store with lid open. 

Ensure that the kit is ready to 
provide long lasting operation. 

 Monthly 

Component Inspection Additional Notes 

Complete Kit Perform all inspections in the previous sections.  Ensures that users are ready 
for the next survey. 

Sound Speed 
Probe 

Compare surface sound speed probe with another 
sensor. If it is not within 1m/s difference and the 
comparison conditions are similar, then determine 
which sensor is bad and return for calibration. 

The surface sound speed 
sensor should provide reliable 
data for an 18-24-month 
period. 

 Annually 

Component Inspection Additional Notes 

Complete Kit Perform all inspections in the previous sections.  Ensures that users are ready 
for the next survey. 

INS Annual 
Warranty 

The integrated INS require its own annual maintenance.  
The latest INS firmware versions necessitate an active 
maintenance warranty that must be kept up to date and 
without lapse. Please contact NORBIT support prior to 
any INS FW update.  

Applanix releases important 
performance updates via 
NORBIT tested and approved 
firmware version. Contact 
NORBIT for more information. 

 Biennially  

Component Inspection Additional Notes 

Complete Kit Perform all inspections in the previous sections.  Ensures that users are ready 
for the next survey. 

WBMS 
Calibration 
Services 

Long term use requires preventative maintenance and 
calibration service for the sonar. It is recommended to 
send purchased system once every two years for a 
calibration service. The first bathymetric WBMS systems 
are still in operation as they have been cared for and 
returned to the factory for increased longevity. 

Calibration service includes 
surface sound speed 
calibration. 
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1.10 Hull mounted and bio-fouled systems cleaning procedure 

The procedures below outline the safe way to clean hull mounted systems or those with extreme 
biofouling. Please ensure that these steps are followed exactly as outlined, as failure to do so could 
result in damage to your system. If there are any questions or doubts about these procedures contact 
NORBIT support. 
 

⚠ 
 

CAUTION:  Do NOT use Power Washer  

If cleaning a hull mounted system, a power washer must not be used. This 
will irreparably damage the system. If hauling out the vessel for hull cleaning, 
ensure that those cleaning the hull are informed about not putting any part of 
the power washer stream on the NORBIT system.   

 

⚠ 
 

CAUTION:  Superfine Abrasives Only 

When using scrubbing pads on the NORBIT, ensure that you are using a 
super fine abrasive pad such as 3M™ Scotch-Brite™ Light Cleansing Hand 
Pad 7445. A very abrasive scrubbing pad will damage the polyurethane on 
the sonar. 

 
 

1. Remove the system from the vessel and place water and 

dust resistant caps on the sonar bulkhead as well as the end 

of the cable. 

2. Manually remove as much fouling from the sonar as 

possible.  

3. Obtain a bucket large enough to fit the entirety of the sonar. 

In the container, mix in a 50/50 ratio of CLR® (Calcium, 

Lime, Rust cleaner) to water.  

4. With the bulkhead cap tightened, completely submerge the 

system in the 50/50 solution for approximately 2 hours. 

5. Remove the sonar from the solution and scrub the sonar 

using a super fine abrasive pad and water. 

6. If the system still has fouling, repeat the soaking process. 

This process can be repeated until all biofouling has been 

removed from the system.  

7. Allow the system to dry fully prior to storage.  

 

 
 
 
 
 
 
 
 
 
 
 
 

Cleaning of system with a 
power washer, causing 
exposure of the ceramics. 
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1.11 Factory Calibration 

NORBIT recommends that the WBMS and SIU be sent back to NORBIT for factory calibration every 
two years. The calibration will examine the WBMS and the SIU. In addition, the sound speed sensor 
will be calibrated. The factory calibration will ensure that the WBMS maintains high data quality and 
repeatability.  
 
The Calibration turnaround is typically one week, if scheduled ahead through NORBIT support. It is 
the responsibility of the user to schedule the calibration. NORBIT will not recall systems for 
calibration. 
 
For integrated INS kits, it may be necessary to update the INS firmware. INS firmware upgrade may 
incur additional cost as deemed appropriate by Applanix. Please contact NORBIT Support to find 
out if this applies to your system. Keeping up to date is important to take advantage of rapidly 
changing latest positioning techniques. 

1.12 Options & Upgrades  

If necessary, NORBIT offers the following affordable upgrades:  
 

• Custom cable lengths. Please specify length with order. Maximum is 50m. 

• NORBIT acquisition software – DCT (Data Collection Tool) 

• 3rd party Bathymetric/Hydrographic survey data acquisition & processing software 
▪ HYPACK & HYSWEEP 
▪ QINSy, Qimera & Fledermaus 
▪ EIVA 
▪ CARIS  
▪ BeamworX 

• GNSS RTK Base Station Kit. Simple to use RTK base station with/without FCC license 
free radios. 

• Post Processed Kinematic Software. Offers centimeter positioning even with GNSS 
outages. 

▪ For Compact: Waypoint Inertial Explorer (NovAtel) 
▪ For iWBMS: Applanix POSPac MMS (Trimble)  
▪ GNSS Base for PPK 

• High-Resolution Forward-Looking Sonar. Visualization, navigation and or obstacle 
avoidance. 

• Deep mode (200kHz center frequency) for 550m depths 

• Integrated LiDAR utilizing the same SIU as the integrated WBMS 

• Dual-Head WBMS 

• 1° Transmit array 

• 100, 4500 & 6000m Depth Ratings (WBMS only) 

• Performance neutral antifouling paint.  

• Diagnostic/Preventative Service 

• Onsite Support and Training. From classroom instruction to on-project support service 

1.13 Support 

For basic troubleshooting, please refer to the Troubleshooting section in this document. For further 
support please contact NORBIT Subsea Support: 
 
NORBIT Subsea AS 
Stiklestadveien 1 
7041 Trondheim 
Norway 

Phone: +47 739 82 569 (UTC+2) * 
Email: subsea_support@NORBIT.com 
*UTC time offsets above may be ±1hr off due to 
daylight savings time 

mailto:subsea_support@norbit.com
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 Hardware Installation 

For well-seasoned multibeam users, a quick setup plan is found in Quick Start. All first-time NORBIT 
WBMS operators, however, are strongly encouraged to fully review this manual prior to commencing 
a survey project. The warning boxes may not cover all critical notices. 
 
 

⚠ 

CAUTION:  Properly Seal Wet-End Connection 

Inspect O-Ring each time before connecting wet-cable and replace as 
needed. Apply a thin coat of synthetic grease (e.g. Molykote 55) to the O-
Rings. Strongly hand-tighten wet-connector (push in and tighten repeatedly 
until firmly connected). If connector sticks when tightening, apply a very thin 
coat of grease to the threads. 

 
 

⚠ 

CAUTION:  Voltage Limitation on DB9 

The DB9 connection on the SIU is not rated for voltages higher than 5V. 
Application of voltages on any pin of the connector over 5V will damage the 
system. Check all potential connections for unexpected voltages. 

 

2.1 Power Requirements 

The WBMS family of systems requires clean power for proper operation. As most vessels utilize an 
inverter for this purpose it is important that it be a true sine wave inverter. A modified sine wave 
inverter may cause unexplained issues even when using the included power brick. In general, 
inexpensive inverters are likely modified sine wave. Use high quality inverters for providing power to 
the WBMS family of systems. If dirty power is assumed, connect the system directly to a 12-24VDC 
battery and test.  
 
Additionally, power can be provided directly from a 12V deep cycle battery using the included pigtail 
that plugs into the power port on the SIU. 
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 Power Consumption 

The following table outlines the expected power draw for NORBIT multibeam systems. This list does 
not cover all configurations but covers most current configurations. Contact NORBIT support if your 
power requirements dictate a lower power consumption. There are several ways in which lower 
consumption can be achieved. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

System Average Maximum 

WBMS-bathy_Pn_12003-AACDB4 40W 55W 

WBMS_STX_Pn_12003-APBDD4 50W 65W 

WBMS-bathy_Long Range_Pn_12003-AACDB2 40W 60W 

iWBMSc_Compact_Pn_12005-AACDB4 45W 65W 

iWBMSe_Pn_12006-AACDB4 55W 70W 

iWBMSe_Long Range_Pn_12006-AACCB2 55W 70W 

iWBMS_Pn_12004__AACDB4 60W 75W 

iWBMS-Long Range_Pn_12004-AACDB2 60W 75W 

iWBMSh_Pn_12007-AACDB4 60W 75W 

iWBMSh STX_12007-APBDD4 70W 80W 

iWBMSh_Dual Head_Pn_12007-DACDB4 100W 160W 
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2.2 Wet-End Overview 

 WBMS Sonar Head 

The WBMS sonar is comprised of a cylindrical receiver array and a cylindrical projector array. The 
receiver housing contains latest FPGA boards where all sonar processing occurs. Data leaving the 
WBMS wet-end is ready for survey data acquisition via Ethernet protocol. 
 
 

 
 

 iWBMS, iWBMSh, iWBMSe & STX Sonar Head and IMU 

iWBMS, iWBMSh, iWBMSe and STX models contain the well-known Applanix GNSS/INS systems. 
The systems are equipped with either a MEMS-based or one of two FOG IMUs. The systems are 
optionally available with POSPac MMS for full positioning and attitude PPP or PPK solutions. The 
IMU is housed inside the ballistic grade front fairing of the wet-end assembly. 
 
 

 

 
iWBMS with standard 1.9°projector. The 0.95° projector adds only 10cm to the length. 

 
 
 
 

Projector Array 

Cylindrical Receiver Array 

Sonar Cable Connector 
(always inspect the O-ring, 
lubricate and replace as 
necessary) 

Sound Speed Probe 

Anodized Aluminum 
Housing 

IMU Cable 

IMU Inside 
Front Fairing 

Sonar Cable 

Delrin Mounting Bracket 

Projector Array 

Sound Speed Probe 



 
 
 
 

 

10.4.3 User Manual                                       Contents April 17, 2020 
Firmware: 5.2.1   Page 18 of 142 

 

The iWBMSe has the Applanix SurfMaster (AP-18) while the iWBMSc comes with the Sensor 
STIM300 IMU and NovAtel antennas for a complete GNSS/INS system. These MEMS-based IMU’s 
are housed inside the projector of the wet end assembly for both systems resulting in a very compact 
form factor. Some customers request the iWBMSe IMU to be mounted on the front nose (like the 
iWBMS/iWBMSh) so that they may be easily upgraded later. The systems are optionally available 
with POSPac MMS or Waypoint Inertial Explorer for full positioning and attitude PPP or PPK 
solutions.   
 
 

 
 
 

⚠ 
 

CAUTION:  Voltage Ratings 

The DB9 and PPS connections on the SIU are not rated for voltages higher 
than 5V. Application of voltages on any pin of the connector over 5V could 
damage the system. Check all potential connections for unexpected 
voltages. Do not input a PPS pulse into the BNC connection of the 
integrated SIU as this could damage the GNSS boards inside the system. 

 
 
The newly introduced STX comes in two models: 200kHz and 400kHz, with up to a 1x1° beam width 
transmission capability. The lower frequency system is optimum for deeper water applications. Like 
the iWBMS systems, the STX may be integrated with an inertial measurement unit (Applanix 
WaveMaster II or OceanMaster) for a complete bathymetric solution. The dimensions of the STX 
with 1x1° projector will be nearly identical to that of the iWBMS. The STX provides a versatile 
bathymetric tool – it can be used as a forward-looking sonar or operated as a conventional multibeam 
bathymetric sonar. The topside interface unit is identical to the SIU-I-NAV described earlier. To 
provide yet another option, the STX, in bathy mode, may be coupled to another NORBIT sonar to 
form a dual-head system for increased coverage and faster results. However, due to the STX’s 
higher power requirements a dual-head system compromising of at least one STX will require two 
topside units. The STX, like other WBMS systems, can be controlled via the WBMS GUI 10.4.0. 
Detailed descriptions of the GUI and STX offsets will be in later sections. and the related offsets will 
be outlined in a later section. 
 
 
 
 
 

Delrin Mounting Bracket 

IMU Inside Projector 
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2.3 Dry-End Overview 

All WBMS systems include a compact topside Sonar Interface Unit (SIU) which distributes power, 
time information and data between the sonar wet-end and the survey acquisition system. This 
environmentally sealed fan-less topside is dust-proof and splash resistant, facilitating worry-free use 
on vessels with little to no protection from the elements. 
 
 

⚠ 

CAUTION:  Cover Connection Ports 

When operating in open environments, all connection ports on the SIU 
should be tightly sealed either with the NORBIT supplied cables or, if the 
port is unused, with the port covers provided with the system. 

 

 WBMS Sonar Interface Unit (SIU) 

 

 
PN: 29024 

 
 
 
 
 
 
 
 
 
 
 

 
*Please note that SIU-I model 29024-5 and newer will not have the 6A fuse in the rear. Instead there will 
be an internal 20A fuse 

 
 
This SIU works with all WBMS Bathy, STX and FLS systems. The iWBMSe and iWBMSc require an 
18-pin to 10-pin adaptor. 
 
The SIU will shut down automatically at 70°C to prevent damage to electronics due to overheating.  

                           
 
 
 
 
 
 

Connector Description  

Sonar LEMO Interface cable to the sonar 

GPS RS-232 ZDA Timing input  

PPS BNC 1 PPS input for external sensor 

Ethernet RJ45 For communication between topside PC and sonar 
SAMTEC Part# RCE-01-G-05.00-D 

AUX LEMO For communication with auxiliary devices 

Power LEMO 
FUSE SOCKET* 

Input DC voltage 
Rear; 6A slow-blow 
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 iWBMS Sonar Interface Unit (SIU-I-NAV) 

 

 
PN: 29028 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
  

* Please note that NORBIT has a split serial option.  This option allows for ASCII/Binary output of 
GNSS/INS information to 3 serial connections.  Please contact NORBIT support for more information. 
**Please note that SIU-I-NAV and SIU-I-Compact-NAV models 29028-5, 29029-3 and newer will not 
have the 12A fuse in the rear. Instead there will be an internal 20A fuse. 

 
 
The SIU will shut down automatically at 70°C to prevent damage to electronics due to overheating. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Connector Description  

Sonar LEMO 18-pin interface to sonar and IMU 

Ant 1 TNC Primary GNSS antenna. Antenna closest to WBMS 

Ant 2 TNC Secondary GNSS antenna 

GPS RS-232* GNSS corrections input (RTK/DGPS) 

PPS BNC 1 PPS output for external sensor (not typically used) 

Ethernet RJ45 For communication between topside PC and sonar 
SAMTEC Part# RCE-01-G-05.00-D 

AUX LEMO 10-pin interface for communication with auxiliary devices 

Power LEMO 
Fuse Socket** 

Input DC voltage 
Rear; 12A slow blow 
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 LED Status Indicators & Description 

All SIU versions have activity LED’s that behave as detailed below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 SIU Aux Port 

The 10-pin Aux port on the integrated SIU allows users to expand WBMS capabilities by integrating 
additional sensors. For the full pin description, refer to the appendices at the end of the manual. The 
Aux port can connect to an additional WBMS to operate in a traditional dual head configuration with 
either sonar projecting down, or one looking forward for obstacle avoidance in challenging 
environments.  This port can also communicate with the iLiDAR, a topographic laser, to 
simultaneously collect multibeam and topographic data.  For further information on these options 
please contact NORBIT. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Indicator Pattern Description 

Sonar LED Off 
Led Blinking (ISO) 1Hz 
Blinking 1Hz 
Green steady 
Blinking 5Hz 

Sonar Off 
Sonar Booting 
Sonar Stand By 
Sonar pinging 
Sonar Over Current Failure 

PPS LED Orange blinking (1Hz) 
Orange blinking (5Hz) 
Off                                                 
On, steady 

Sync/timing ok 
No sync, NMEA missing                                       
No sync, NMEA and PPS missing                                     
No sync, PPS missing 

AUX LED Always OFF 
 

Not currently in use 
 

Power LED Green 
Green – flashing at 5Hz                           
Off 

Input voltage ok 
Input voltage <10v or >28V 
No input voltage 

ETH Flashing Applanix/NovAtel established valid 
Ethernet connection 

Msg Flashing Applanix/NovAtel receiving RTK 
corrections 

SV Flashing Applanix/NovAtel detecting satellite 
vehicles 



 
 
 
 

 

10.4.3 User Manual                                       Contents April 17, 2020 
Firmware: 5.2.1   Page 22 of 142 

 

2.4 Mounting Considerations 

 Installation Planning 

The integrated WBMS family of sonars are engineered for greater simplicity and efficiency of 
installation; these systems were designed to be mounted on any marine vessel. For any questions 
about mounting, please contact NORBIT Support. If not using an integrated WBMS, then fixing the 
IMU on the survey pole reduces the need for well-designed and robust mounting systems that allow 
the most minimal flexing with respect to the survey platform. 

 
 

 

 
 

Review the survey platform (ship, launch, jet-ski, sea-kayak, USV, ROTV, ROV, AUV, etc.), record 
the vessel layout and where cables could be secured to avoid tripping hazards or require chafe 
protection. Have a walk around the vessel to best formulate the most ideal install locations. Attempt 
to mount the systems nearest to vessel CoR. This is often off the port or starboard gunwale at the 
fore/aft location of the approximate CoR. Beware of hull reflections or bubble sweep-down; mount 
the sonar at or below the keel depth. 
 
To reduce the likelihood of unexpected equipment failure and data quality degradation, care must 
be taken when routing sensor cables on a vessel. Run the cable as far as possible from high power 
electrical cables or devices. Electrical interference from such sources may result in loss of system 
performance. It is advised to keep bends in the cables to a minimum and to avoid kinks, twist or 
unnecessarily stretching the cables. Avoid pinching them in windows, doors and other equipment. 
Cables should be secured to avoid excess movement or prevent wear on the cable sheath. Long 
cables should be kept away from power sources and separated from itself (not coiled tightly and 
placed in a corner) to avoid electrical interference. 
 
The sonar cable is simply a bundled LAN and DC power cable. It is possible, therefore, for cables 
to easily be repaired on-site by an experienced electronics technician. Please contact NORBIT 
support for detailed guidance. Cable length may be up to 50m or be ordered to a custom length. 
 
 

⚠ 

CAUTION:  Cables Are Not Wet Mateable 

Only connect cables to connectors when dry. Use compressed air to ensure 
they are clean and dry. 

2m separation 

Forward 

Generally, mount WBMS 0.7m below 
waterline, and certainly below the keel 

Placing all sensors on a common 
pole mount brings greatest ease 
and flexibility   

Primary antenna is 
closest to WBMS 
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Prior to installation, always inspect cables for nicks and sheath wear. If there are any hazards that 
may expose cables to abrasion, it is advised that a chafing guard to protect the cable be made such 
as adding rubber tape around the cable at the point of concern. Ensure pins are not bent and that 
they are shiny for robust connectivity. 

 Sonar Mounting Location 

Generally, the WBMS Reference Point should be clear of the lowest part of the hull, at the mounting 
location. This is to avoid reflections from hull and water surface. A strong hull-reflection will reduce 
SNR for all beams (simply rotating the wedge in software will not blank out a strong reflection).  
Additional sonar draft may be required depending on the characteristics of the vessel hull which may 
create bubbles during vessel motion, especially as sea state worsens. It is critical that the sound 
speed sensor on the WBMS has clean bubble-free water.  
 
Mount the sonar in a location that will minimize interference from engine noise and the effect of 
vessel motion on data quality; for most vessels, this location is approximately down 3/4 the length 
of the hull on the port or starboard side. In certain cases, the sonar can be successfully mounted 
near the outboard motors, e.g. on the transom of a 2.5m inflatable boat.     

 
 
 
 
                

  

 

                                            

 
While the antennas may be oriented in any direction horizontally, it is good practice to orient them 
to be parallel or perpendicular to the vessel centerline. 

 
Label the Antenna1 cable at both ends before installation to identify which of the two cables is the 
Primary when connecting to the SIU. 

 Acoustic Clearance Zones 

In shallow water conditions, when danger of collision with sonar is especially high, users may want 
to build a safety cage around the sonar. The image below indicates areas that must be kept clear to 
receive a clean signal. 
 

 

Clear of Keel 
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2.5 Sensor Mounting 

 WBMS Sonar Head 

The sonar must be mounted with the transmitter (projector) pointing aft, so that the receiver is 
measuring in the quietest, least turbulent water for best SNR. Mount the sonar in-line with the keel 

or centerline of the survey platform and parallel to the water surface to within about 0.5°. Higher 

misalignment and offsets between sensors will translate to a higher error in sounding position. 
Consequently, it is best to mount all sensors (sonar, IMU, GNSS antennas) as close together as 
possible. 
 
It is best practice to feed the sonar cable through the mounting pole to protect against vibration or 
flotsam collision during surveys. The sonar cables should never be connected or disconnected 
underwater. Ensure connectors are always clean and dry. Screw on the protective caps on sonar 
wet-end, cables and SIU when system is stored. 
  
The bolts that secure the sonar to the pole/bracket should be 30-35mm longer than the thickness of 
the mounting bracket and made of high-quality stainless steel to prevent corrosion especially in 
saltwater environments. Use a lock washer and/or an anaerobic thread adhesive such as Loctite 
242 Blue to prevent loosening of sonar during long deployments.  

 
It is also possible to permanently hull mount the sonar. For more information refer to section 2.5.4. 

 
 

 

 

 

 

 

 

 

 

 

 

 

⚠ 

CAUTION:  Electrically Isolate WBMS from Metal Boat 

If using a custom-built WBMS mount that is not provided by NORBIT, please 
use a non-conductive plate to electrically isolate the sonar. This will help 
prevent corrosion. 

 
 
 
 
 
 

✓ ✗ 
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 iWBMS Sonar Head & IMU 

As noted in the section above, the sonar must be mounted with the transmitter (projector) pointing 
aft. Mount the sonar in line with the keel or centerline of the survey platform to within 0.5°. This is 
not so critical when the entire assembly is mounted to a single survey pole. 
 
Accommodations must be made for the sonar/IMU cable when mounting. Cables must run up 
through the center of the iWBMS(x) bracket. 
 
 

⚠ 

CAUTION:  Run Cables Through Center of Bracket 

The mounting bracket requires that wet-end cables be run through the top 
center opening of the iWBMS(x) bracket, which is attached to customer 
supplied sonar mounting pole. If the mounting pole is a pipe (recommended), 
its minimum inner diameter should be 5.8cm. If a pipe is not used, ensure 
that exposed cables are securely fastened to avoid damage. 

 
 
Use at least 4 bolts (2 forward and 2 aft) made of high-quality stainless steel to ensure of anti-
corrosion especially in saltwater environments. Use a lock washer and/or an anaerobic thread 
adhesive such as Loctite 242 Blue to prevent loosening of sonar during long deployments. 
 

 
 
The bolt hole pattern shown above is applicable for all integrated WBMS systems. The sonar and 
IMU cables should never be connected or disconnected underwater. Ensure all connector pins and 
sockets are clean, dry and shin. Always use the supplied connector caps on wet-end, cables and 
topside. Use a synthetic O-ring lubricant on connector O-rings that are in good condition. 
 
If pole-mounting the iWBMS(x), the cables should be run through the sonar pole. The pole should 
have a minimum internal diameter of 5.8cm to allow the connector(s) to pass through. The iWBMSe 
and iWBMSc requires the pole be centered over the single connector. 
 
The iWBMS(x) has been tested at a transit speed of 20 knots without damage to the system. If not 
conducting a survey, it is best to transit with the sonar out of the water especially if the mount is less 
robust. This is to protect the system from physical damage from flotsam. 
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 GNSS Antennas 

GNSS antennas should be mounted on a stable structure that will not wobble or flex during surveys. 
They must have a clear view of the sky to the horizon so that every satellite may be continuously 
tracked without obstruction and are as far as possible from transmitting devices such radars and 
radio antennas. The GNSS mounting locations should be free from vibration and rigid with respect 
to each other and the IMU. 
 
 
 
 
 
 
 
 
 
 
The Primary Antenna (or Antenna 1) should be nearest to the IMU so that offset measurement errors 
are minimized. 
 
The Secondary Antenna (or Antenna 2) should be a fixed distance from Antenna 1. It is 
recommended that the antennas be at least 2m apart. Shorter distances may be used but will likely 
result in decreased performance, which can be mitigated by using a higher-grade IMU. The 
separation must be rigid and not flex by more than 5mm during the survey. The antennas should be 
positioned parallel to the water surface to within 2-3cm. 

 Hull Mount 

The WBMS can be permanently hull-mounted to a vessel for operations that do not require the 
system to be portable. The following images are examples of hull-mounted assemblies. When hull-
mounting, the sonar pod must be carefully designed to prevent formation of bubbles and to allow 
water to flow over the SV sensor.  
 
 
 

 
 

 
 

To inquire about NORBIT’s complete hull-mounted design and installation service, please contact 
subsea_support@NORBIT.com 
 
 
 
 
 
 
 

mailto:subsea_support@norbit.com
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2.6 Time Synchronization (for Non-Integrated Systems) 

Timing is crucial for synchronizing signals from the sonar, GNSS and IMU. Only the WBMS requires 
PPS & NMEA ZDA hardware input. All integrated WBMS systems receive timing from the internal 
GNSS card. The system can handle baud rates from 4800 to 115200 and will have no problem 
maintaining sync with other NMEA messages output on the same port as the ZDA+PPS. Ensure 
that the baud rate is fast enough to allow throughput of all strings. 
 
The PPS can be input in two ways: 

• To BNC “PPS” connector on SIU 

• To Serial “GPS” DB9 connector on SIU (pin 9 for pulse & pin 5 for ground) 
 
The PPS signal can be either active low or active high. The SIU synchronizes to the falling edge of 
an active low signal, or the rising edge of an active high signal. The voltage on the PPS should not 
exceed 5V, doing so may cause unwanted issues. In addition, the time duration should be 1µ-200ms.  
 
For the standalone WBMS, the SIU should receive a PPS TTL input at 3.3V (5V tolerant). The SIU 
can autodetect negative or positive PPS input and has ±15kV ESD protection, ±60V fault protection. 
 
The integrated GNSS/INS WBMS systems can output a (positive or negative configurable) PPS TTL 
signal at 5V. However, this is NOT fault protected and is rated for a maximum absolute voltage of 
6V. 
 
 

⚠ 
CAUTION:  Don’t Connect Active PPS to SIU for Integrated Systems 

The integrated versions of the SIU outputs PPS pulses. Attaching an active 
PPS cable to this port will damage internal electronics and void the warranty. 

 

 
The timing cable pinouts are as follows: 
 

Connector A Connector B Connector C Description 

1 1 1 Not Connected 

2 2 2 Transmit Data (from GNSS) 

3 3 NC Receive Data (to GNSS) ex. for NTRIP 

4 NC NC Not Connected 

5 5 5 Ground 

6 NC NC Not Connected 

7 NC NC Not Connected 

8 NC NC Not Connected 

9 NC 9 PPS (from GNSS) 
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To connect a GNSS to a stand-alone WBMS, the accompanying timing cable should be used. The 
cable splits the signal so that both the survey computer and SIU can be connected to the same port 
from the GNSS. 

 

 

The following are two examples of ways to connect the SIU and PC to the GNSS: 
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 Offsets & Reference Points 

For quality, repeatable bathymetric data, the offsets between the sonar, attitude and positioning 
sensors on the survey platform must be fixed and well known. The 3 axes should be accurately 
aligned with the survey platform, or any angular misalignments should be measured and applied to 
the acquisition/processing software. 
 
Each sensor has predefined measurements between the WBMS Reference Point (sonar acoustic 
center) and the IMU Reference Point, the WBMS Reference Point and the Top Center of Bracket, 
and the IMU mounting angles. The relevant offsets and misalignments are applied automatically in 
the WBMS GUI, so the user does not have to input them. The only case where the user must know 
these values is if a custom installation is used, or if the Applanix firmware is older than 9.03 and all 
offsets are entered manually in POSView. 
 
By default, all data output from the integrated systems (position, attitude and depth information) is 
valid at the WBMS Reference Point. Thus, all sensors in the acquisition and processing software 
must have the same offset to this location. The offsets for each sonar are detailed in the next section. 
 
Note that Top Center of Bracket is merely a convenient point from which to measure other sensors; 
however, no data output is valid at this location. 
 
 

⚠ 

CAUTION:  Upgrade Applanix Firmware for NORBIT 10.4 

For iWBMS, iWBMSh and iWBMSe, the integrated Applanix must have at 
least 9.03 firmware. This enables the NORBIT GUI to take control of the 
system and automate many of the setup parameters. Users of older firmware 
versions are encouraged to contact NORBIT Support for upgrading. 
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3.1 Reference Points 

In the drawings below, the WBMS Reference Point (red dot) is where all sonar and navigation data 
are valid by default. This point is located at the center of the projector in the fore-aft direction, and 
at the center of the cylindrical receiver array in the port-starboard and vertical directions. 
 
The green dot indicates the IMU Reference Point. Generally, the user need not concern themselves 
with the IMU reference point, unless the IMU is physically decoupled from the sonar. 
 
The purple dot indicates the Top Center of Bracket. This is merely a convenient point from which 
to measure the primary GNSS antenna offset, as the WBMS and IMU reference points are not 
necessarily physical points that can be directly measured. 

 
Refer to section 3.2 for all relevant offsets and mounting angles for each WBMS configuration.  
 

Sonar Kit and Bracket PN Side View Front View 

12004 & 12007 
iWBMS, iWBMSh 

Projector: Standard 1.9° 
Bracket PN: 35021 

 

 
 

12004 & 12007 
iWBMS, iWBMSh 

Projector: Narrow 0.9° 
Bracket PN: 35021 

 

 
 

12005 & 12006 
iWBMSc, iWBMSe 

Projector: Standard 1.9° 
Bracket PN: 35047 
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3.2 Sonar Offsets & Mounting Angles 

Sonar Kit and Bracket PN Name in GUI 

Sonar Part No. 
(* denotes values that 

may be ignored for 
this purpose) 

WBMS Ref. Point to 
IMU Ref. Point 

(+Fwd, +Stbd, +Down) 

IMU 
Mounting 

Angles 
(+Port up, 
+Bow up, 

+Clockwise) 

WBMS Ref. Point 
to Top Center of 

Bracket 
(+Fwd, +Stbd, 

+Down) 

12004 iWBMS, 400kHz 
(Applanix WaveMaster) 

Bracket PN: 35021 
IMU PN: 24006-4X 

iWBMS-0.9°x1.9° 
24003-*-*C**** 

24003-1b (legacy) 

0.198, 0, 0.079 90, 0, -90 
0.122, 0, -0.07 

IMU PN:  24006-8X 0.206, 0, 0.079 0, -90, 0 

12004 iWBMS, 200kHz 
(Applanix WaveMaster) 

Bracket PN: 35021 
IMU PN: 24006-4X 

iWBMS-1.9°x1.9 24007-*-*C**** 
0.241, 0, 0.078 90, 0, -90 

0.170, 0, -0.07 

IMU PN:  24006-8X 0.256, 0, 0.079 0, -90, 0 

12004 iWBMS, 400kHz 
(Applanix WaveMaster) 

Bracket PN: 35021 
IMU PN: 24006-4X 

iWBMS-0.9°x0.9° 
 

24003-*-*B**** 
 

0.248, 0, 0.079 90, 0, -90 
0.172, 0, -0.07 

IMU PN:  24006-8X 0.255, 0, 0.079 0, -90, 0 

12004 STX, (Applanix 
WaveMaster) 

Bracket PN: 35021 
IMU PN: 24006-4X 

iSTX-0.9°x0.9° 24016-*-*B***B 
0.234, 0, 0.079 90, 0, -90 

0.158, 0, -0.07 

IMU PN: 24006-8X 0.242, 0, 0.079 0, -90, 0 

12005 iWBMSc, 400kHz 
NAV Kit (NovAtel) 
Bracket PN: 35047 

iWBMSc-0.9°x1.9° 24005-*-*C**** 0.061, 0.022, 0.102 90, 0, -90 0.117, 0, -0.023 

12006 iWBMSe,  
(Applanix SurfMaster) 

Bracket PN: 35047 
iWBMSe-0.9°x1.9° 24018-*-*C**** 0.053, 0, 0.096 0, 0, 180 0.117, 0, -0.023 

12006 iWBMSe, 
(Applanix SurfMaster) 

Bracket PN: 35047 
iWBMSe-0.9°x0.9° 24018-*-*B**** 0.103, 0, 0.095 0, 0, 180 0.167, 0, -0.023 

12006 iWBMSe, 200kHz 
(Applanix SurfMaster) 

Bracket PN: 35047 
iWBMSe-1.9°x1.9° 24022-*-*C**** 0.100, 0, 0.095 0, 0, 180 0.188, 0, -0.023 

12007 iWBMS NAV (Applanix 
OceanMaster) 400kHz 

Bracket PN: 35021 
iWBMS-0.9°x1.9° 24003-*-*C**** 0.198, 0, 0.079 90, 0, -90 0.122,0, -0.07 

12007 iWBMS 400kHz 
(Applanix OceanMaster)  

Bracket PN: 35021 
iWBMS-0.9°x0.9° 24003-*-*B**** 0.248, 0, 0.079 90, 0, -90 0.172, 0, -0.07 

12007 STX 
(Applanix OceanMaster) 

Bracket PN: 35021 
iSTX-0.9°x0.9° 24016-*-*B***B 0.234, 0, 0.079 90, 0, -90 0.158, 0, -0.07 

SONARS NO LONGER IN PRODUCTION 

12005 iWBMSc, 400kHz 
(NovAtel) 

Bracket PN: 35027 
iWBMSc-0.9°x1.9° 

 
24005-*-*C**** 

 
0.076, 0.022, 0.102 90, 0, -90 0.087, 0, 0.07 

12006 iWBMSe, 400kHz 
(Applanix SurfMaster) 

Bracket PN: 35021 
iWBMSe-0.9°x0.9° 24003-*-*C**** 0.175, 0, 0.079 90, 0, -90 0.122, 0, -0.07 
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 System Operation 

The sonar system is configured and controlled by the WBMS GUI. Several computers each with an 
installed GUI may be connected to the sonar, yet only one may be the primary and control the sonar 
system, while the secondary computers monitor operation. 
 
The sonar may also be controlled in headless/passive mode. See Section 4.1.3 for more information. 

4.1 WBMS GUI Installation 

For all systems with integrated Applanix inertial navigation systems, POSView is no longer required, 
provided the installed Applanix firmware is v9.03 or later. If in doubt, please contact NORBIT with 
the product serial numbers (dry-end and wet-end units) for the latest compatible software. 
 
The software installation file is provided on a USB stick inside the shipping case or it can be 
downloaded from a link provided by NORBIT via email.  
 
Navigate to the provided USB stick or the email sent from NORBIT, click on the executable file 
(WBMS_89001_XYZ.exe, for example) and follow the prompts. This installs the WBMS Graphical 
User Interface (GUI) and copies firmware to the PC. Upon connection to the sonar, a check of 
firmware compatibility is performed. If there is a firmware mismatch, the user is prompted to update 
the firmware. Click Perform Update, as described in section 4.3. It is very important that power be 
maintained to the sonar during the update procedure. 

 PC System Requirements 

Since all sonar data processing happens inside the sonar head, the GUI can be run on the same 
computer as the acquisition software. The following are the recommended minimum system 
requirements. The system requirements may change depending on acquisition software used. 
 

 
 

 
*The GUI may work on Windows 7 if Microsoft Visual C++ 2015 (Redistributable Update 3 RC) is installed on the PC. The 
installation file is provided in the USB drive. It can also be downloaded free of cost from Microsoft. Microsoft has stopped 
mainstream support of Windows 7 as of January 13, 2015. Starting with 10.3 NORBIT does not test software for compatibility 
with Windows 7.  

 
The WBMS systems are network based, which enables the user to run the Graphical User Interface 
(GUI) software on the same computer as the acquisition software or even on separate computers. 

Hardware Requirements 

Operating System Windows 10 Pro is recommended  
Windows 8.1 (Fully Updated)  
Windows 7/Vista/XP * - Unsupported 
(Windows XP is untested) 

Computer Processor 2-GHz or better 

Computer Memory 4-GB or more 

Screen Resolution 1400x900 or higher 
*Screens with lower resolution can be used however data visualization 
may be reduced. This will not impair data acquisition 

Graphics Card (Optional)  

Internet Connection 100/10000Mbit Ethernet card  

HDD Only GUI: <1GB, Full system with logging: > 100GB 

https://www.microsoft.com/en-us/download/details.aspx?id=52685
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 iWBMSc (Compact) INS GUI Installation 

If operating the Compact model, be certain that the included NovAtel Connect software is installed. 
Only version 1.8 and later should be used with the Compact. Navigate to the 
NovAtelConnect_Setup.exe provided by NORBIT and follow the prompts. For detailed 
instructions on setting up and utilizing NovAtel Connect please go to Connecting INS to Connect. 

 Operation Without GUI (Headless/Passive Mode) 

Some setup of the NORBIT WBMS, such as AUV/ROV may require use of the system without the 
NORBIT GUI. NORBIT refers to this as headless mode. When operating in this mode, users can 
interface with the sonar on a script level, directly giving commands to the sonar without the use of 
the NORBIT interface. 
 
For other users requiring the GUI to only monitor sonar operation, a passive mode can be selected 
in the GUI. This allows the sonar state to be monitored in the GUI, and at the same time allow for 
other methods of sonar control via custom software etc.  
 
For further information on either of these modes please contact NORBIT support. 

4.2 Network Configuration  

The WBMS and integrated WBMS versions connect to the acquisition computer via a 1 Gigabit 
Ethernet network cable from the SIU. To communicate with the SIU, the computer network adaptor 
must be configured to the same subnet as the SIU.   
 
To set up the IP address of the computer navigate to your 
laptop/PC network adaptor setting and change the 
TCP/IPv4 settings. It is important that the last 3 numbers 
of the computer IP address not conflict with the IP address 
of the WBMS or the INS. The INS systems come pre-
configured with an IP address of 192.168.53.100. The IP 
address of the sonar is always 192.168.53.XX, where XX represents the last two numbers of the 
WBMS serial number (found on the sonar head, next to the cable connector). A subnet mask of 
255.255.255.0 should be used. NORBIT recommends setting the IP address of the laptop/PC to 
192.168.53.150, to avoid conflict with other systems. 

 
In rare circumstances, some users may wish to change the IP address of the sonar. For instructions 
on how to do this, see the Troubleshooting section in this document. It is recommended to NOT 
change the sonar IP address unless necessary. A forgotten sonar IP address will require a lengthy 
unbricking process. 
 

⚠ 

NOTE: Changing IP Address of INS Disables GUI Functionality 

Changing the IP address of the Applanix INS from the factory configured IP 
address (192.168.53.100) will disable all INS capabilities within the GUI. 

 WBMS DHCP Connection 

Unless otherwise required, please make sure that DCHP servers are not running on the same 
network as the sonar. During boot up, this will cause an automatic assignment of IP address. If this 
occurs, and a DHCP network is not desired, then power off the SIU, assign a static IP address to 
the computer and then re-power the SIU. 
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4.3 Connect to Sonar 

Upon launching the GUI, the Connection Dialog is displayed. If a sonar is active and, on the 
network, a green light is displayed next to it. A red light indicates that the sonar is not online. If a red 
light is shown, and the sonar is powered on, check the network configuration (see section 4.2). 
 
When a green light is displayed, select the sonar to highlight it and press Connect. After the first 
successful connection is made, all subsequent connections to the sonar are automatic. 

 
Once connected, an automatic check is performed to ensure that the firmware is compatible. A 
warning is displayed on the Connection State tab if the firmware is incompatible. To correct this, 
click Perform Update and follow the on-screen instructions. 
 
Please note that it is unsafe to turn off power to the sonar once the upgrade process has started, 
and that doing so risks corrupting the system configuration. Operating a firmware and GUI with 
mismatching versions may cause unstable operation. 

 

    
 
When the upgrade is complete, reboot the sonar and follow the connection procedure as described 
above. 
 
The menus shown above are described in more detail in section 4.6.5. 
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4.4 INS Tools for iWBMS, iWBMSh & iWBMSe 

NORBIT has integrated Applanix functionality to the NORBIT GUI, meaning that both the sonar and 
INS may be setup and controlled from the same user interface. The INS Tools are found at the 
bottom of the settings menu, and the INS Setup Wizard allows users to configure offsets and GNSS 
corrections. 
 
For users with standalone WBMS systems, or iWBMSc, most settings under INS Tools are greyed 
out. Users with integrated systems must have Applanix firmware v9.03 or later. To request an 
upgrade, open POSView and select View > Statistics, and send a screenshot of this display to 
NORBIT Support. The currently installed firmware is shown under POS Version, and is highlighted 
in the example below. 
 

   
 

 

⚠ 

NOTE:  Firmware Upgrade Cost 

For some users, firmware upgrades may incur additional cost from Applanix. 
To find out if this applies to your system, please contact NORBIT support 
with a screenshot of the Statistics window, as shown above. 

 

 INS Setup Wizard 

 Factory Settings 

NORBIT advises that, prior to each new installation, the factory default settings are restored. Open 
the INS Setup Wizard and select Factory. Note, this only resets the INS configuration and has no 
impact on the sonar configuration or GUI display preferences. 
 
 

⚠ 

CAUTION:  Incorrect Offsets When Changing Computers 

Offsets entered in the wizard are stored on the computer from which the 
setup was performed. If the survey computer is changed, the displayed 
Measure Point to Antenna Bottom offset is from WBMS Ref. Point (not 
Top Center of Bracket) to primary antenna phase center. Although the 
displayed offset is incorrect, it does not affect operation unless the 
configuration is re-saved. To display the correct offset, it must be re-entered 
and saved. NORBIT recommends reviewing all inputs prior to each survey. 
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Applying factory settings configures the system to output Ethernet Realtime groups 1, 3, 7, 10, 

11, 20, 102, 103, 111, 112, and 113. 

 
It also configures Ethernet logging to record groups 1, 2, 4, 5, 9, 10, 99, 102, 110, 
111, 112, 113, 10001, 10007, 10008, 10009, 10011, 10012, 20000 Diagnostics, 

and Applanix Diagnostics, as well as ZDA and PPS for sonar timing. This data can be used 

to extract delayed heave (also known as True Heave), or to post-process GNSS data using POSPac. 
 
Note that the above group selections are pre-configured and cannot be changed in the NORBIT 
GUI. All groups required by the acquisition software (HYPACK, QINSy, PDS, EIVA, etc.) are 
included in the pre-configured selection. 

 

 IMU Offset & Mounting Angles 

The first page of the setup wizard shows the sonar model in the System selection and the relevant 
offsets and mounting angles applicable for that model. The model is automatically detected, and for 
most users there is nothing to change here. 
 
The offsets are collapsed by default. To display them, click the down arrow. If custom offsets or 
mounting angles are required, select the Custom system option. This is only required for advanced 
installations, where the IMU is physically decoupled from the sonar and installed at a separate 
location on the vessel. 
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 Antenna Offsets 

Offsets related to the GNSS antennas are found on the second page of the setup wizard. Select the 
Primary Antenna model, which in most cases will be Trimble 540AP, to ensure that the correct 
phase center offset is applied. 
 
Select the Measure Point to define a convenient 
reference point from which to measure the primary 
antenna offset. Top Center of Bracket should be 
selected; however, a Custom point may also be defined. 
The system uses the entered antenna offset, together 
with the offset from WBMS Ref. Point to Measure Point, 
to relate the antenna position to the sonar. 

 
Carefully measure the distance from Measure Point to 
Antenna Bottom and enter the correct values, bearing 
in mind the sign convention (positive down). 

 
Should a positive value be entered for the down offset, a 
warning message alerts users that a positive value 
places the sonar above the GNSS antennas. The user is 
prompted to verify that the correct offset has been 
applied. If a special mounting arrangement is employed 
and a positive number is correct, the warning may be 
ignored. 
 
Users can specify the Heading Threshold for the 
heading alignment procedure which follows later. The 
Default Value (0.5⁰) is suitable in most cases. It may be 
necessary to change the threshold, e.g. if operating a 
large vessel and aggressive maneuvering is not feasible. 
If the heading calibration does not start within 30 minutes, 
select Custom and increase the threshold in 0.5⁰ 
increments until the calibration starts successfully. Every 
time a heading alignment is performed, a patch test 
should be performed afterwards. 
 
For Heading Alignment method, select Heading Alignment Wizard to populate the fields in 
Primary to Secondary Antenna Baseline Vector with zeros initially. Correct values are displayed 
after the calibration is complete (described in section 4.4.2). If the antenna baseline vector is already 
known, i.e. if it was measured using land survey techniques, the results can be entered manually by 
selecting Custom. 

 
Selecting Plan View or Profile View displays a diagram showing the antenna positions with respect 
to the WBMS Reference Point. This can be used for a visual check of the system layout/offsets. 
 

⚠ 

NOTE:  NORBIT GUI and POSView/POSPac Offsets Are Different 

The offsets displayed in POSView (and POSPac) for Ref. to Primary GNSS 
Lever Arm are not the same as those entered in the NORBIT GUI. The 
NORBIT GUI offsets are referenced from the Measure Point (typically Top 
Center of Bracket), whereas the POSView/POSPac offsets are referenced 
from WBMS Ref. Point. 
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 Center of Rotation Offset 

The vessel Center of Rotation (CoR) offset should be entered relative to the Measure Point. Note 
that the center of rotation is more of an area rather than a well-defined point on the vessel, therefore 
an approximation will suffice. Select Use CoR Offset and enter the measured values under 
Measure Point to Center of Rotation (CoR). 
 
The vessel center of rotation is a point on the vessel that 
experiences only rotations with changes in attitude. Any 
heave measured at this point arises entirely from vertical 
movements that affect the whole vessel equally. The 
multibeam transducer, being some distance from the 
vessel’s CoR, will therefore experience a small 
component of heave as the vessel moves vertically in the 
water, and a much larger component of apparent heave 
with changes in vessel attitude. 
 
To separate these effects, the INS can translate the IMU 
measurements to the vessel CoR. Having done so, it applies filtering to the measurements of pure 
heave and then translates the filtered measurements back to the heave record. 
 
This method for measuring heave avoids the errors that can occur if you filter direct heave 
measurements made from a point different from the vessel CoR. 
 
By entering these values in the GUI, the user avoids a possible heave artefact that may occur as 
the INS records the heave measurements made from an IMU that is not located at the vessel CoR.  
Applanix systems apply a dynamic filter to the heave record to normalize the vertical data back to 
zero over time. This can result in a visible heave artefact if the vertical orientation of the sonar is 
constant for a period. 
 
 

⚠ 

NOTE:  Artefact Scenario 

If the weight on a boat was shifted port or starboard for multiple minutes 
during a survey, the sonar would be moved vertically in the water column. At 
the beginning of this vertical shift, the heave would be recorded correctly.  
However, after a period the heave value would start to settle back to zero 
and the location of the multibeam in the water will not be recorded correctly. 

 
 

The CoR, for most commercial vessels, is documented in the vessel design plans. For other vessels, 
this point at which the vessel’s roll and pitch axes intersect must be determined. This location can 
be hard to determine, as the vessel CoR may change from day to day and even during the day. For 
smaller vessels, the CoR moves depending on fuel stowage and even distribution of personnel body 
weight. Generally, choose a CoR location that is about ¾ distance from bow to stern, centered on 
the keel, and located at approximately water level. Choose a location and attempt to keep the weight 
distribution constant throughout the survey. If in doubt, take the boat to open water and measure its 
motion while passing over waves in different directions. 
 
It should be noted that these offsets only impact heave calculations and do not impact positioning. 
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 Integrated DGNSS 

The Integrated GNSS page of the setup wizard allows 
users to specify the desired satellite GNSS correction 
service. Satellite Based Augmentation Service (SBAS) 
may be configured here. This is a correction source that 
is regional and free. 
 
Alternatively, Marinestar, a paid subscription service 
providing decimeter accuracy, may be selected. Refer to 
section 4.4.5 for details on activating a subscription. 

 

 RTK/Aux GNSS Input & NTRIP Client 

If no RTK or auxiliary GNSS is interfaced, select Off for each input. Otherwise, select the signal 
input source (COM port or Ethernet). Depending on the selections made, additional options may 
become available. 
 
RTK corrections may be transmitted to the vessel from a 
land base station, via radio, and interfaced to the system 
via the serial COM port on the SIU. The radio on the 
vessel must therefore have a serial output, containing 
only the correction message. The incoming radio baud 
rate must match with the selection in the setup wizard. 
 
Select the correct RTK Input Type (CMR, CMR+, CMRx, 
RTCM, etc.) as well as the input Line, either Serial or 
Modem. Please note that if an input type other than None 
is selected, the INS only uses GPS satellites, so it will 
likely result in fewer satellite vehicles being detected. 
Selecting None enables the INS to use additional 
satellites from other constellations such as GLONASS. 
 
Select the desired NMEA output messages. If using a 
radio link to receive corrections, you may need to set this 
output to Off to avoid issues related to decoding the 
correction message from the radio’s output. 
 
When an external GNSS system is used, select Aux. 
GNSS Input. Then enter the offset to the auxiliary 
antenna phase center. It is important to note that this 
offset must be measured from the WBMS Ref. Point (see 
section 3.1) to the phase center of the auxiliary antenna. 
When the auxiliary system is connected, the INS 
compares its own solution against the quality of the 
auxiliary solution and automatically selects the best. 
 
 
 
 
 
 

 

https://www.fugro.com/our-services/marine-asset-integrity/satellite-positioning/marinestar
https://www.fugro.com/our-services/marine-asset-integrity/satellite-positioning/marinestar
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To enable RTK corrections via NTRIP, select Ethernet as the RTK/DGNSS Input. Select NTRIP 
Client and enter the login details. Select Fetch Sources, and then select the source from the 
dropdown menu. Click Connect. 
 
When the NTRIP client shows Bytes Received and Bytes Sent values increasing, a connection is 
established. If, for any reason, the numbers are not increasing, select Disconnect and Connect to 
restart the service. Losing connection to the internet, even for a brief period, may cause the NTRIP 
connection to fail. 

 

   
 
The client may be accessed at any time by selecting INS Tools on the settings menu, then select 
NTRIP Client. The connection status can be monitored on the INS status bar at the top of the GUI. 
 
Click Finish to complete the setup wizard. If Heading Alignment Wizard was selected in section 
4.4.1.3, finishing the setup wizard automatically starts the alignment wizard. If performing a heading 
alignment calibration is not possible at this time, you may select Cancel, with no loss of input values, 
and perform the calibration later.  
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 Heading Alignment Wizard 

A heading alignment must be performed when the iWBMS is first installed, or when one of the INS 
sensors (IMU or GNSS antennas) is moved. The heading alignment determines the vector offset 
from primary antenna to secondary antenna, and in doing so ensures proper alignment of the IMU 
with the GNSS antenna pair. 
 
If a heading alignment was not performed at the end of the INS Setup Wizard, select INS Tools > 
Alignment Wizard and follow the on-screen instructions. 
 

Step 1. With the Alignment Wizard open, press Start to 
begin the calibration. The best results are 
achieved using RTK GNSS, with a clear sky view, 
away from tall structures that impede GNSS 
performance. The installation must be completely 
rigid and free from vibration. The primary antenna 
offset must be accurately measured and applied 
during the INS setup stage described in the 
preceding section. 

 
 
Step 2. Follow the recommended maneuvers during the 

pre-alignment stage and observe the display as 
the Heading Error RMS decreases from its initial 
value of 55 degrees. Once the value drops below 
the defined threshold (Target Error) and 
stabilizes, the heading alignment begins. 
Continue to maneuver the vessel until this 
occurs. 

 
 

Step 3. Follow the instructions and continue to perform 
figure-of-eight maneuvers while the heading 
alignment is in progress. The overall time to 
complete the calibration depends on the size of 
the vessel and the speed at which the maneuvers 
are performed, as well as positioning quality. 
 

 
 
Step 4. The computed results are displayed and are 

unique to each installation. If the primary to 
secondary antenna baseline was manually 
measured beforehand, the calculated results 
should be very similar. Check that the results are 
sensible and select Commit to save the results. 
NORBIT recommends performing a patch test 
after the heading alignment. 
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 Understanding Heading Alignment Results 

Understanding the alignment results allows the user to verify the installation 
and refine it if necessary. 
 
The heading alignment establishes the baseline vector from primary to 
secondary GNSS antenna. The X, Y and Z components of the vector from 
primary to secondary antenna should closely match with the measured 
values. Although it is not required to manually measure the values, it is 
strongly recommended to do so as a check. 
 
In this example, where the antennas are mounted along the X (fore-aft) 
direction, the Y component of the heading alignment can be used to check 
if the iWBMS is in alignment with the antennas. A small value in the Y 
component indicates that the iWBMS is closely aligned with the antenna 
orientation. A larger value indicates that the iWBMS is mounted with a yaw 
offset with respect to the antennas, as shown in the image. This can be 
used to bring the antennas and iWBMS into alignment either by adjusting 
the mounting angle of the WBMS in the Z axis, or by adjusting the antennas. 
By using an iterative process of adjustment and calibrations, the user can 
achieve a high degree of alignment between the antennas and the WBMS.   
 
The Z component is the vertical separation between the 2 antennas.  

 

 Sky Plot 

The Sky Plot displays currently tracked satellites on the primary and secondary GNSS antennas. 
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 System Status 

The System Status window displays the status of the INS system and reports any fault conditions 
that may occur during operation. Check this display if the Faults indicator on the GUI status bar 
appears red. Note that some items may display a red indicator intermittently during initialization and 
operation. 
 
The example below shows a system without any errors. This window may serve as an important 
diagnostic and troubleshooting indicator. 
 

 
 
Version information is displayed at the bottom. It displays all INS related hardware, software and 
firmware versions. For users requiring an authorization code to upgrade the INS firmware, NORBIT 
support may ask for a screenshot of this display. 
 
Additionally, the Marinestar Status, and importantly the subscription expiry date, is shown on the 
right-hand side. 
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 Subscribing to Marinestar 

Follow the steps below to activate a Marinestar subscription for decimeter-level GNSS corrections, 
assuming RTK is not available: 
 

1. Select INS Tools > System Status and obtain the OMNSN number: 
 

 
 

2. Go to http://www.fugroMarinestar.com/Order_form and request a subscription. In your 
request, you must supply the OMNSN number from the previous step.    

3. Arrange a time with Fugro to activate the subscription, as the system must be powered on 
and tracking satellites when the activation code is transmitted. Be sure to consider time 
zone differences when organizing the activation time. 

4. Enable Marinestar in the INS Setup Wizard, as described in section 4.4.1.5. In most 
cases you can leave the selection to Auto, however you may be advised to set a specific 
mode and frequency by Fugro, in which case choose the Custom option. 

 

 
 

5. Prior to your arranged activation time, ensure that the system is powered on and tracking 
satellites. Advise Fugro when the system is ready.  

6. It may take 30-45 minutes after the code is sent for the subscription to activate. 
7. Confirm that the subscription is valid by observing the System Status window. If it is active, 

you should expect to see the status updates as well as an updated expiration date. When 
the system utilizes Marinestar corrections in the INS solution, the INS status displays Pri. 
Marinestar… when the mouse is moved over the Status indicator. 

 

 
 
 
 

http://www.fugromarinestar.com/Order_form
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 Logging 

The GUI automatically logs raw Applanix INS/True Heave data when the GUI is launched, using the 
Applanix binary (*.000) format. The log folder path is displayed by hovering over the Logging 

indicator:  
 
The logging location may be changed by selecting Advanced > Options > Paths. It is also possible 
to disable logging, by deselecting GNSS/INS Raw Observables. NORBIT recommends that users 
do not disable INS logging. Refer to the Advanced section for more details.   

 
The *.000 file serves a dual purpose. First, it may be applied as True Heave in post-processing to 
reduce heave artefacts, without the need for a POSPac license. The example below shows a 
comparison of data with real time heave (left) and True Heave (right). 
 

   
 

Secondly, the *.000 files can be processed in POSPac MMS for application of PPK data with 
improved position quality. Post-processing the GNSS data allows RTK dropouts to be recovered. 
 

 TSS1 

For standalone (non-integrated) WBMS systems, a TSS1 message can be interfaced from an 
external motion sensor for roll stabilization. The TSS1 message should be interfaced to the computer 
via a COM port. Select Use TSS1, then select the COM port and Baud Rate. Click OK. The baud 
rate must match the output from the motion sensor. 
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4.5 Main WBMS GUI Display 

When a successful connection is established, the sonar wedge is displayed, and logging of 
GNSS/INS raw observables automatically begins. Backscatter data may also be displayed. The 
image below shows an example of the main display with both raw sonar and GNSS/INS data being 
recorded. 
 

 
 

The sonar wedge shows a single ping of data from a thin slice of the water column. The wedge 
comprises 256 or 512 overlapping beams, which each contains a depth sounding. 

 
The sonar wedge is used to assess data quality and swath coverage. Currently applied settings and 
statistics are summarized and displayed right of the sonar settings, and left of the sonar wedge, e.g. 
frequency, sound speed, date and time, and ping number. The software and firmware versions are 
displayed at the top right corner. Check the NORBIT support web pages to verify that you have the 
latest version. 

4.6 Sonar Settings Menus 

The left column contains several expandable menus. NORBIT recommends that the View menu 
always be expanded, as this requires the most attention and operator input. 
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 View  

Most sonar control features can be found in the View menu. The 
user may specify Gate Mode, the Upper and Lower Gates, 
Swath angle and swath pointing Direction. The table below 
describes each function in detail. 

 
Sonar range is a function of the Lower Gate, angular Swath width 
and swath pointing Direction. These parameters affect the total 
distance bottom detections can be from the sonar, and the ping 
rate is then determined by factoring in the speed of sound in water.  

 

Function Description 

Gate Mode 

Allows for selection of manual gates by upper and lower depth (Depth mode), by upper and 
lower range (Range mode) or by upper depth and lower range (Mixed mode). Depth gates 
are suitable for most environments. Range gates are ideal for shallow water bank to bank 
surveys, or when changing the Direction. A bottom search is performed between the Upper 
Gate and Lower Gate independently for each beam. When Depth mode is active, changing 
the Direction, or operating with a physically tilted head may drastically reduce the ping rate. 
To avoid this, select Range or Mixed mode. 

Upper Gate 

Sets the upper limit (minimum depth) for bottom detections. Change values by entering a 
number and press Enter, by using up/down arrows next to the corresponding control bar, or 
by interactively clicking and dragging the gate to the desired depth on the wedge. For most 
surveys the minimum should be at least 1m to avoid false detections at the surface. 
Minimum Value: 0.1m 
Maximum Value: 599m 

Lower Gate 

Maximum depth for calculating bottom detections. Change values by entering a number and 
press Enter, by using up/down arrows next to the corresponding control bar, or by 
interactively clicking and dragging the gate to the desired depth on the wedge. 
Minimum Value: 1.0m 
Maximum Value: 600m 

Swath 

User-defined total angular swath coverage. For typical harbor dredge surveys, this value is 
normally set to 120-150° 
Minimum Value: 5° 
Maximum Value: 210° 

Direction 

Direction of swath pointing angle. 0° places the swath symmetrically around nadir. Under 
normal operations, direction angle is dependent on swath width as no portion of the swath 
may exceed the 179° allowable view. If the survey requires that depth be attained above the 
sonar draft, the direction can be extended further up by first selecting 180° Swath. Next select 
the desired Direction, then select the final desired overall Swath. Useful when surveying 
slopes, shoreline or for mapping structures such as piers, bulkheads, etc. To maximize the 
ping rate while using this feature, it is recommended that Range mode be activated and 
regularly adjusted. Use of Depth mode may yield low ping rates when using this feature.  

Automatic 
Zoom 

Makes the active portion of the wedge full screen. This ensures that detections are clearly 
visible on the display, even when the range is very high. This is most effective when using 
Adaptive Ping Rate with a large lower depth/range gate. 

 
 

⚠ 

CAUTION:  Steering Direction Limited in Equidistant Mode 

In Equidistant mode, the swath angle cannot be increased such that any 
part of the swath exceeds an 80° pointing angle, i.e. 10⁰ from horizontal (so, 
a 160° swath with 0° rotation or a 120° swath pointed 20° is the maximum.) 

 



 
 
 
 

 

10.4.3 User Manual                                       Contents April 17, 2020 
Firmware: 5.2.1   Page 48 of 142 

 

 Backscatter Controls  

Backscatter Controls change the data dynamics and apply gain 
to fit in the dynamic range of the output data format (s7k). The 
sonar hardware has a limited time varied gain (TVG) which 
operates up to around 30m. Thereafter, TVG yields a constant 
level. This may be a problem for some processing software when 
creating seamless mosaics. The Apply TVG option removes this 
native sonar TVG applied by the hardware and instead applies the 
user specified TVG described by the mathematical formula: 
 

TVG = Spreading*Log10 (R) + 2*Absorption*R/1000 + Gain 
 

This TVG curve is a standard continuous function to let the signal fit in the data format (s7k) range 
and prevent signal saturation. This digital gain is applied to all imagery output data: side scan, 
snippets, snippet-side scan and water column. For most cases, a Static Gain setting of -15dB, 
spreading 40 and Absorption of 80dB/km will sufficiently scale the data.  
 

Function Description 

Apply TVG Removes the native sonar TVG that is applied in the sonar hardware and instead applies the 
user specified TVG, based on Static Gain, Spreading and Absorption. When TVG is 
applied, all parameters are reported along with the data to the acquisition software to more 
effectively process the data e.g. for mosaicking. When the option is deselected, the native 
sonar TVG is not removed and no additional digital gain is applied to the data. Therefore, it is 
prudent to always enable this option. 

Static Gain Sets a fixed gain value that is used to together with Spreading and Absorption to form the 
TVG curve. The default setting of -15dB is suitable in most cases. Adjust this setting if the 
sonar signal becomes saturated, in which case the SS/WC/SN indicator will appear red on 
the main GUI display (see section 4.7). 

Spreading Sets the spreading component of the TVG calculation. Spreading loss is a geometrical 
phenomenon in which signal intensity is reduced as the range increases and wave fronts are 
spread over an increasingly larger area. The default setting is 40. 

Absorption Sets the absorption component of the TVG calculation. Transmission loss due to absorption 
is caused by conversion of acoustic energy into heat. The rate of absorption loss depends on 
the water environment and sonar operating frequency. The default setting of 80dB/km is 
recommended for 400kHz operation. 

Backscatter 
Mode 

Sets the backscatter mode to one of three options: None, Side Scan, or Snippet/Scan, the 
latter of which is a side scan composed of snippet data. Snippet collection rate will be limited 
to maximum 18Hz. These limits to data output rate were implemented to ensure smooth 
collection of data without burdening computational resources. If side scan data is requested 
by the acquisition software when Snippet/Scan mode is selected, snippet-side scan will be 
generated so that (unlike regular side scan) a correctly positioned side scan can be derived 
from snippets data. When surveying with a WBMS STX model, if snippets and/or side scan 
data are required, users are advised to deactivate Scanning in Tx Pulse Settings. If the goal 
is to classify bottom types, collection of Snippets will be most helpful. If that is not the case, 
snippets should be deactivated to conserve disk space and computational resources. 

View 
Backscatter 

Displays backscatter data under the sonar wedge. Even if it is not displayed in the GUI, 
backscatter data is still sent to the acquisition software if a TCP subscription is made. The 
SN/SS indicators at the top of the GUI appear green when a subscription is active. 

WC 
Resolution 

Sets the resolution of water column data. Water column data is output on record 7042. It is 
advised to keep the resolution low when computational resources are scarce. 

View WC Displays water column data on the sonar wedge. WC data collection is limited to 5Hz. Note 
that it will only be recorded to raw wbm/s7k files if the View WC checkbox is enabled. 
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⚠ 

CAUTION:  Snippets Is Data Intensive 

To ensure smooth data collection, make sure that the acquisition PC is not 
near its maximum CPU load. If CPU load is too great, artefacts may appear 
in the snippets record. 

 

 Tx Pulse Settings      

The Tx Pulse Settings control the acoustic transmission (Tx) 
signals. Typically, with default settings, these values are 
automatically determined based on sonar range. For most survey 
applications, these settings need not be changed.   
 
If the GUI detects a WBMS STX model, this menu activates 
additional options to allow transmit pulse steering. These controls 
are not visible if a standard WBMS is detected. All functions are 
explained in the table below. 
 
For additional information on STX operation, refer to section 5.3. 
 

 

Function Description 

Frequency Sets center frequency of transmitted pulse. The WBMS is optimized for a center frequency of 
400kHz for standard systems and 200kHz for deep/long range systems. For a given depth, 
higher frequencies theoretically have higher bottom detection resolution, but also higher 
signal attenuation, especially in the presence of sediments. For most applications, however, 
NORBIT recommends maintaining a frequency close to the center frequency of that system 
(200 or 400kHz). 
Standard Systems: 200kHz – 700kHz (optimized for 400kHz) 
Long Range Systems: 160kHz – 400kHz (optimized for 200kHz) 

Mode Sets sweep time of the signal transmission. The available selections are FM Long Range 
(recommended setting for most applications), FM Short Range (applicable for surveys in very 
shallow water, less than 5m), or CW (legacy option). With FM Long Range, a long sweep 
time of 500µs is used. The FM Short Range option reduces this value to 200µs. Decreasing 
sweep time increases effective ping rate. For CW mode, the duration of the signal 
transmission increases range performance at the expense of detection quality. NORBIT 
systems are optimized for FM operation. 

Resolution Sets the acoustic range resolution by controlling pulse bandwidth. The resolution is calculated 
as c/2*BW, where c is the speed of sound and BW is the bandwidth. When maximum 
resolution (0.9cm) is set in FM Long Range or FM Short Range modes, 80kHz bandwidth is 
used. Therefore, with a center frequency of 400kHz, transmission sweeps from 360-440kHz. 
Decreasing resolution enhances range performance in deep water by reducing bandwidth. In 
CW mode, frequency transmission is constant, i.e. 0 kHz bandwidth. However, the system is 
designed from conception as an FM system and performs optimally in this mode, yielding 
highest resolution regardless of depth. Auto selection is recommended. 

Automatic 
Mode and 
Resolution 
(Auto) 

Adjusts Mode and Resolution for best performance in nearly all survey conditions, as 
determined by the software. For backscatter, unless very high ping rate is desired in shallow 
water, disable Auto and set Mode to FM Long Range and Resolution to 0.9cm to ensure 
full processing of the backscatter signal. The system will otherwise switch between 200 and 
500µs and some software cannot process out the signal change. 
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Ping Rate Sets the rate at which acoustic pulses are transmitted. Certain factors such as depth will limit 
the maximum achievable ping rate. For instance, in deeper water, lower ping rates will be the 
norm since signal travel time and path length from projector to reflective bottom, and then 
back to receiver, are longer. Tx pulse Mode also affects ping rate. The system automatically 
transmits with 200µs sweep time in shallow waters so that maximum ping rate is maintained. 

Ping Rate: 
Full Range 

If enabled, sets the ping rate to maximum possible value over the total effective range as 
defined by the Swath width, swath Direction and Lower Gate. Ping rate is a function of the 
two-way travel-time of the signal from projector to the bottom and back, plus a small duration 
for ping processing and capacitor charge. The effective range is determined from the angular 
swath width, swath pointing angle and lower depth or range gate. 

Ping Rate: 
Adaptive 

System searches for greatest bottom detection range based on adaptive gate over a certain 
number of pings and revises the transmission timing to match this. Lower Gate may therefore 
be set to very deep values, but the system will ping at a much higher rate as it is based on 
maximal adaptive gate for range. This is ideal for high resolution data over rapidly changing 
bottoms or for surveys that don’t allow for full-time, hands-on operators (e.g. on AUVs). While 
operating in this mode, sonar bandwidth and sweep time are determined by the Lower Gate. 
If surveying in shallow waters, the Lower Gate should not be set too deep unless Auto 
Mode/Resolution is disabled. 

Ping Rate: 
Fixed 

Sets the maximum ping rate of the sonar. Even if possible, the sonar will not ping faster than 
the fixed rate. Useful for general bathymetric surveys with deep and shallow water to reduce 
data volume in very shallow waters as the system will continually attempt to ping as fast as 
possible up to the user defined threshold or the sonar range. 

Ping Rate: 
External 

Most users do not require this. Ping is triggered externally and only happens if the sonar is 
‘ready’ when the signal arrives, e.g. if the sonar cannot ping faster than 10Hz due to range, 
but the external signal is 12Hz, then every other event will be skipped resulting in a 6Hz ping 
rate per every other signal. The external signal polarity is configurable. Minimum delay from 
transmit signal to center of transmit pulse is 500µs (half the transmit pulse buffer plus 
additional). An adjustable trigger delay is possible in millisecond resolution. 

Scanning 
(STX only): 

If checked, this option directs sonar to sweep an along-track sector of angle given by Opening 
Angle. If unchecked, the sonar is directed to ping in one direction, effectively behaving as a 
conventional multibeam sonar. NOTE: It is not advised to conduct an entire multibeam 
survey with scanning active. Use scanning only when attempting to further develop 
areas of interest. For most applications, step size should be limited to 20.  

Steps 
(STX only): 

This is configurable only if Scanning is enabled and the opening angle is set to a non-zero 
value. The number of steps corresponds to the number of slices, or pings, in each defined 
along-track sector. 

Direction 
(STX only): 

The value in this field defines the angular direction forming the center of the along-track 
sector, e.g. for a direction of 5°, and opening angle 20°, the STX will scan across a sector 
from -5° to 15°. 

Display all 
Ang (STX 
only): 

If checked, this instructs the GUI to display all angles in the sector being scanned by the STX. 
If unchecked, the GUI will display the angle defined in Display Angle. 

Display 
Angle 
(STX only): 

If Display all Ang is unchecked, this field will be greyed out. However, if the previous field is 
unchecked, the user may define a single angle within the sector to visualize on the display.  
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⚠ 

CAUTION:  Data Quality Is a Function of TX Pulse Settings 

High quality sonar data requires excellent Signal to Noise (SNR). Therefore, 
the sonar Tx Pulse Settings directly impacts data quality. For most 
conditions (temperature & salinity dependent) use FM Long Range mode 
and 0.9cm resolution. If useable swath width becomes narrow (due to noisy 
outer beams) then gradually decrease Resolution. If in doubt. use Auto 
selection. 

 
 

⚠ 

CAUTION:  Bottom Classification Surveys Using Snippets 

If backscatter data quality is the priority of the survey, deactivate Auto and 
manually define Mode and Resolution. Changing these settings during a 
survey, or operating in Auto mode, may cause data degradation as the 
processing software is not able to compensate for variable pulse 
characteristics. In general, FM Long Range mode should be used, however 
this limits the ping rate to a maximum of 20Hz. If a faster ping rate is 
required, select FM Short Range. 

 

 Advanced  

It is prudent for the sonar operator to understand the Advanced 
settings in the rare event that they need to be changed. 
 
If a WBMS STX system is utilized, an additional checkbox appears 
for activating pitch stabilization. Note that pitch stabilization should 
not be used when Scanning is selected. 
 
When Multidetect is selected, additional options become 
available to control the detection sensitivity and customize the 
output. All functions contained are explained in the table below. 
 

 

 

Function Description 

Adaptive Gates Adaptive Gates work in a similar way to upper/lower gates, except they follow the 
shape of the seafloor. Note that they are not visible on the sonar wedge. If the gates 
are too narrow, bottom detections may be noisy for large depth changes. In areas with 
steep gradients it is recommended that the gates be turned Off. If the gates are too 
wide (or off), false bottom detections may occur due to noise, second returns or fish. 
The following applications are well suited for the corresponding settings: 

• Dredging Surveys: Normal Adaptive Gates 

• Engineering Surveys: Normal or Wide Adaptive Gates 

• General Bathy Surveys >40m: Narrow Adaptive Gates 

• General Bathy Surveys <40m: Normal Adaptive Gates 

• Wreck or Complex Structure Surveys: Wide Adaptive Gates or Off 

In some sea states the gates may need to be set wider to avoid cutting out data during 
large roll events. It is advisable to use adaptive gates in nearly all environments. 
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Sound Speed This option controls how the surface sound speed is applied. If Auto Sound Speed is 
selected (recommended) the sonar only takes in values from the sensor installed at the 
sonar head. If this sound speed probe fails, users can disable the auto option and 
manually input the speed, based on a sound speed profiler for example. An incorrect 
surface sound speed will irreparably compromise the beam pointing direction resulting 
in bad data. Minimum value is 1300m/s, maximum is 1700m/s. When Auto Sound 
Speed is deselected, the last value at the head is used to populate the SV value. Please 
note that this range reflects default hardware capabilities. For marine conditions 
requiring a larger range, other models of the sound speed probe are available; please 
contact NORBIT for more information. 

Auto Sound 
Speed 

If this option is selected the speed of sound is read from the probe at the sonar head.  
This is recommended unless the probe is damaged, out of calibration or there are too 
many bubbles affecting the data quality, e.g. when surveying in rapids or surf-zone. If 
necessary, this option may be deselected, and the value set manually. If the sonar is 
powered on and out of the water, or there are excessive bubbles, the GUI displays a 
warning that the sonar is “Out of water”. If the sonar is pinging out of water, it 
automatically takes measures to prevent damage due to overheating. If the sonar 
temperature exceeds 65°C it will shut down automatically as a safety precaution. 

Roll Stabilization Roll stabilization allows for a wider swath width in more dynamic sea states. Roll 
stabilization compensates up to ±10º of roll and is limited to 160º swath angle. Note that 
roll stabilization is unrelated to roll compensation for georeferencing purposes, which is 
handled separately. 

Pitch 
Stabilization 
(STX only) 

When activated, pitch stabilization allows for pitch compensated transmit beams for a 
more even along-track coverage with minimal loss. STX scanning must be 
deactivated prior to use. 

Pulse Amplitude Sets the pulse amplitude (transmission power). For shallow waters (<10m) in highly 
reflective areas (lock chamber, for example) it may be necessary to reduce the pulse 
amplitude to reduce acoustic reflections/noise in the survey area. Otherwise it is best 
to leave it set to 15. 

Beam 
Distribution 

There are 4 modes to select from:  

• Equiangular 512 or 256: The angular swath coverage is divided equally by 
512 or 256 (the total number of beams) to determine angular beam spacing. 
Use to increase resolution around the nadir zone. 

• Equidistant 512 or 256: The maximum chord distance of the swath is divided 
by 512 or 256 to determine the linear beam spacing. Use to increase resolution 
at outer swath edges. There is a short 1 second lag when switching modes. 
Do not switch while logging data. 

Sonar Tilt Specifies the tilting angle in special mounting configurations such as dual head when 
the sonar is mounted at an angle. Allows the user to normalize the display in the GUI, 
otherwise a flat seafloor will appear as a slope. Note, additional considerations are 
required when the integrated IMU is tilted; refer to technical note TN-190018 for details. 

Multidetect As of GUI release 10.4, users can collect up to 3 detections per beam: one extra 
detection above and below the bottom detection. The upper and lower gates control 
which part of the water column is considered for extra detections. The Adaptive Gates 
control how close the extra detection will be to the bottom detection: if set to Wide or 
Off, the extra detections could be further away from the bottom detection, and if set to 
Narrow, the extra detection will be closer to the bottom detection. 

Multidetect 
Sensitivity 

Adjusting the slider increases or decreases the sensitivity of the multi-detection 
algorithm to qualify the water column as a potential extra detection. 

Multidetect in 
S7k Output 

The user can select whether to output an extra detection above (Upper) and/or below 
(Lower) the bottom detection in s7k files generated by the GUI. 
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Options (Display 
Preferences, 
Timing and 
Triggering, 
Paths) 

Display Preferences 
 

Bottom Point Size – Changes the point 
size on the wedge. Adjustable from 1-10. 

Display Text Size – Changes the text size 
on the wedge area. Adjustable from 1-12. 

Roll Rotation – Viewing options to show 
the roll stabilized wedge. 

Water Column Data Image Quality – Sets 
the resolution of the water column display. 
This does not affect output resolution. To 
ensure system resources are kept to a 
minimum for low-grade field laptops, run 
with medium or low graphics selected. 

Units – Selects the display units in the GUI 
to be either metric or imperial. 

Bathymetry Quality Colors – Changes 
color palette of bottom detection quality 
flags. 

Color Map – Offers different color settings for visualizing the swath intensity data. 

Gamma Correction – Changes the visual contrast of the wedge intensity data. 
Setting the gamma too low will mute the intensity in the wedge display to nearly all 
off (black). Setting gamma too high will fuse the darkest areas with brightest areas. A 
value of 2 is often the best. 

 
Timing and Triggering 

Users can specify the synchronization method for sonar timing. For more installations, 
1PPS+ZDA should be selected, in which 
case the GNSS signal provides the time 
stamp and associated 1PPS signal to the 
sonar. 
 
If timing direct from the SIU (via the GNSS 
receiver) is not possible, e.g. on ROV/AUV 
or other types of custom installations, then 
timing from an NTP Server may be used.  
 
NTP+PPS has the same accuracy as 
1PPS+ZDA and is recommended for all 
other installation types where 1PPS+ZDA is 
not possible. A PPS pulse must be sent to 
the system on the timing pin, and an NTP 
server should be made available on the 
network. If the timing error exceeds 10ms, 
the sonar will discard timing. Select 
NTP+PPS pos/neg if using time from an NTP server to provide PPS. “pos” and “neg” 
refers to a positive and negative signal spike, respectively. When this mode is 
activated, an error of >100ms renders the data unusable. 
 
If there is no PPS available, NTP without PPS can be used by selecting NTP Server. 
It possesses less accuracy but is OK to use for platforms with lower dynamics. This 
option requires that the NTP server is at a low STRATUM (<2) value and not too far 
away in the network (public servers are usually not good enough).  
 
More advanced users can use an external signal to trigger the sonar. The External 
Trigger polarity can be set to Rising Edge or Falling Edge. NOTE: For integrated 
systems, triggering via the BNC connector is not possible. Inputting any 
voltage to the BNC of an integrated SIU can cause damage to the internal 
electronics. 
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Paths 

User can specify the folder path for 
recording native NORBIT (*.wbm), 
Applanix (*.000), and s7k (*.s7k) files. Each 
respective format is stored in a different 
folder, e.g. Applanix files are stored in the 
Applanix Logs folder. 
 
Users can choose to disable Applanix data 
logging by deselecting GNSS/INS Raw 
Observables. However, NORBIT 
recommends that this option is always 
enabled. 
 
Note that the GUI must be closed/re-
opened when the recording path is 
changed, otherwise data will continue to be 
recorded to the previous location. 

   

 Connection 

The WBMS operates in a native data format. To ensure compatibility with other data acquisition and 
processing software, the system includes a proxy that translates 
native WBMS data to the well-known s7k data format. The proxy 
is therefore run from the GUI and is initiated automatically. The 
connection can be reset should a conflict arise. If necessary, to 
avoid conflict with other sensors, the Port number can also be 
changed. 
 
In a dual head configuration, the Port number set in the GUI 
applies to the primary sonar only. The secondary sonar port is one 
greater than the primary. For example, if the Port is set to 17000, the primary sonar will use port 
17000, and the secondary sonar will use port 17001. 
 
 

⚠ 

NOTE: Enable Force Push for PDS and EIVA Acquisition 

To receive sonar and INS data into PDS or EIVA, the Force Push option 
must be selected. HYPACK and QINSy users should ensure that this option 
is deselected. 

 

 Connection Dialog & Connection State 

Select Sonar Connection to open the Connection Dialog (described also in section 4.3). Selecting 
Set Sonar Factory Defaults resets the sonar configuration but does not reset the integrated INS. 
NORBIT recommends restoring factory defaults whenever a new version of the GUI or firmware is 
installed. Note that, when this option is selected, raw GNSS/INS logging briefly terminates. 
 
Connection State contains basic information about the current connection status. If any of the 
indicators are red, action is required by the user. Such is the case in the example presented here, 
which shows that the sonar is not loaded with the firmware expected by the GUI. 
 
To shut down and disconnect the sonar, select Connection Dialog, select the sonar on the Known 
Sonars List, and select Disconnect. 
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 Playback 

The Playback tab displays all detected GUI recordings. If there are GUI recordings in other folders, 
USB drives, etc. select Browse and navigate to the correct folder. To play back a recording, double-
click the file name. This opens a second display next to the active wedge showing the recorded data. 
By default, recordings are stored in: C:\Users\<user>\NORBIT\WBMS\ 
During playback, only bathymetry and water column data will be displayed. 
 

  
 
The playback window can be resized by clicking/dragging the central divider. Settings and Controls 
are found on the left. Users can change the Sonar Orientation as required. To export the current 
ping, or a series of pings, use the Export Current Ping and Export buttons. Playback controls are 
displayed at the bottom: 

 

 
 

Other options including s7k export and video export are found on the left menu. 

Go to the beginning 

Step backward (1 ping) 

Play / Stop Step Forward (1 ping) Insert Tag/Comment 

Open Zoom Control 

Insert a Duration Tag 

Repeat Playback 
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 Log, Info & Version 

The Log tab contains a record of system events. This is useful for troubleshooting, and NORBIT 
support may ask for a copy during support cases. 
 
The Info tab contains a record of serial numbers, part numbers, revision numbers, and various 
system statistics. 
 
The Version tab displays the current WBMS GUI version, as well as the current firmware version. 
 

   
 

 Presets 

Users can save preferred sonar configurations to a file by selecting Save Config. These files can 
be loaded by selecting Load Config, as and when required. The saved configuration files are stored 
in the folder: C:\Users\<user>\AppData\Roaming\NORBIT\PredefinedSonarSettings\ 
 
Configuration files contain all sonar settings (frequency, swath 
angle, static gain, etc.) and all GUI display preferences. Users may 
transfer the files between computers to load desired presets. 
 
This functionality allows rapid reconfiguration of the sonar with 
minimal operator input. For example, a preset could be made for 
quay wall surveys with settings appropriate for that application, i.e. Equiangular beam distribution, 
range gates, and swath direction steered to either the port or starboard side. 
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4.7 Upper GUI Status Indicators 

 
 
The first row of indicators (Sonar) shows the streaming status of various data types as it is requested 
by acquisition software. Data not requested shows a grey indicator. If the SS, SN or WC indicators 
are red, it indicates that the signal is saturated. Adjust the TVG 
settings under Backscatter Controls, as described in section 
4.6.2. 
 
The second row of indicators (INS) relate to the function and 
health of the integrated Applanix system. Mouseover the 
indicators to display additional information such as current 
position, GNSS mode, and accuracy. Should a fault be 
detected, more information can be found by selecting INS 
Tools, then System Status. 
 
The Status indicator provides the current solution status 
(RTK, Pri. DGNSS, etc.) as well as the status of the current corrector stream. At times the indicator 
may appear red and may report Pri. Fixed Status. This alerts the user that the correctors have 
changed status and that the RTK fix may soon be lost. Additionally, if using NTRIP, the NTRIP 
indicator may change color to red, indicating a loss in connection. 
 
For users with Applanix firmware v10, the primary GNSS antenna shows many more satellites than 
the secondary antenna. Currently, only the primary antenna is tracking all GNSS constellations and 
SBAS satellites. 

4.8 Lower GUI Viewer Bar 

 
 

By default, the sonar starts pinging once connected to the GUI. The Play  /Stop  button is 
used to start/stop sonar pinging. Once stopped, the Stop button changes to a Play button. Pinging 
should be stopped when the GUI is running with the sonar out of water, to prevent the electronics 
overheating. 
 
Users may also set the Side Scan Length and adjust display 
Brightness. The Brightness control bar only adjusts the wedge 
intensity displayed on the GUI; it does not affect the raw data 
signal. This can be used to effectively increase the illumination of 
received acoustic data. Applying too much brightness will saturate 
the image of the more reflective areas of the acoustic display, while 
applying too little results in a very dark image.  
 
To the right of the Brightness control is the Zoom tool. This opens 
an adjustable pop-up window on the sonar wedge. The window can 
be dragged to any location on the wedge to magnify any segment of the swath. The zoom pop-up 
window remains on top of all open windows. 

 

 

 

Indicator Description 

Bathy 
Bathymetric bottom 
detection points 

SS Side Scan 

WC Water Column  

SN Snippets 

Roll Stab Roll Stabilization Status 
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Displays a time trace for each beam separately when the water column is active. Right clicking 
allows the user to zoom in, while left clicking resets the zoom. Channels can be selected using 
the arrows at the bottom. A graphical selection appears on the wedge. 

 
Hide/unhides the sonar settings menu. The user still has control of the gates, and therefore 
the sonar range, by clicking/dragging the gates interactively on the wedge. 
 

Selecting  activates raw data recording with the native NORBIT format (*.wbm), and 
simultaneously generates files with the s7k format (*.s7k). Recorded data can be played back at any 
time (even during real time sonar operation and recording), as described in section 4.6.5.2. The GUI 
recording files are saved by default in: C:\Users\user\NORBIT\WBMS\. Each recording session 
generates a folder with the naming convention YYYY-MM-DD-HH_MM_SS. If NORBIT requests 
data for a support case, please compress the files beforehand as they may become very large, 
especially when water column is included. 

 Optimizing Backscatter Display 

Tuning the display Brightness and Gamma Correction (in Options) does not have any impact on 
the raw data signal and is only used to adjust the display. However, TVG settings impact data output. 
See section 4.6.2 for details. 
 
To optimize backscatter images visually:  

1. Adjust Brightness on the display control bar 
2. Under Backscatter Controls, ensure that Apply TVG is selected 
3. Adjust the settings for Static Gain, Spreading and Absorption until the side scan image 

appears unsaturated, and ensure that the SS/SN/WC indicators are green. 
 
These settings are dependent on current environmental conditions (water sediment content, salinity, 
temperature, etc.) and may have to be adjusted as the survey progresses. Ensure that the SS and 
SN indicators remain green (unsaturated) as saturated soundings will not be salvageable. 
 

4.9 Data Formats, Recording & Output 

 Raw Data Recording 

Users may record bathymetry data with full motion and navigation data (for Applanix integrated 
systems only) in the native NORBIT format with extension *.wbm. Since NORBIT GUI 10.4 was 
released, s7k files are generated automatically at the same time as wbm files and include True 
Heave data. The s7k format has a publicly available data format definition (DFD). If requested, 
NORBIT Support can provide documentation on the DFD. The logging location for *.wbm, *.s7k and 
*.000 files can be changed by selecting Advanced > Options > Paths. See section Advanced for 
more details. 
 
The data types stored within raw data files depends on the selections made within Backscatter 
Controls.  The View WC Checkbox controls whether compressed water column data is recorded, 
and the Backscatter Mode (but not the View Backscatter selection), controls what backscatter 
imagery is recorded. Note, this is only relevant for raw data files recorded in the GUI and does not 
affect data output to acquisition software (see  
Data Output via Network Subscription.) 
 
All acquisition software subscriptions overwrite selections made in the GUI. Meaning that, if the GUI 
does not have Side scan selected for Backscatter Mode, but side scan is requested by the 
acquisition software, side scan will be recorded in the wbm files regardless. 
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The table below shows what selections are required to log specific data types to raw files in case 
there is no acquisition software subscription. Please note that the View Backscatter selection has 
no impact on recorded data types, whereas the View WC selection does. 
 
Note also that beam intensity values, at the bottom detection point, are recorded within the 
bathymetry packets. This is automatically output and requires no configuration in the GUI. It can be 
used to provide coarse backscatter, separately from the side scan and snippets outputs. 
 

Backscatter 
Mode Selection 

View WC Checkbox Recorded Data Types in WBM file 
7k Records in 

s7k file 

None ☐ 

✓ Bathymetry 

✗ Compressed Water Column 

✗ Side scan 

✗ Snippets 

✓ 7027 

✗ 7042 

✗ 7007 

✗ 7028 

None ☑ 
✓ Bathymetry 

✓ Compressed Water Column 

✗ Side scan 

✗ Snippets 

✓ 7027 

✓ 7042 

✗ 7007 

✗ 7028 

Side scan ☑ 

✓ Bathymetry 

✓ Compressed Water Column 

✓ Side scan 

✗ Snippets 

✓ 7027 

✓ 7042 

✓ 7007 

✗ 7028 

Snippets/scan ☑ 

✓ Bathymetry  

✓ Compressed Water Column 

✓ Side scan 

✓ Snippets 

✓ 7027 

✓ 7042 

✓ 7007 

✓ 7028 

 

 Data Output via Network Subscription 

Currently the NORBIT GUI supports streaming s7k records 7000, 7004, 7006, 7007, 7027, 

7028, and 7042 via the subscription model (record 7500 with ID 1051). All subscriptions can be 

ended with record 7500, ID 1052. 

 
Supported single request records (via record 7500 with ID 1050): 7001 

 
Successful requests are replied with record 7501 (ACK) while unsuccessful ones return record 7502 

(NACK). This is based on RESON’s data format definition (DFD) version 2.43.  The following table 
describes the current s7k records output by the Proxy Server contained in the NORBIT GUI: 

 

Record Description 

7000 Sonar settings 

7004 Beam Geometry 

7006 Bottom detection results (obsolete bathymetric data) 

7007 Side scan data 

7027 Bathymetry data (including beam intensity values for coarse backscatter) 

7028 Snippets data 

7042 Compressed water column data 

7500 7k remote control with ID 1051 

7501 7k remote control acknowledge  

7502 7k remote control not acknowledge 
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 Data Rates 

Estimated data rates for a single head system at maximum ping rate for different subscriptions are 
given below: 
 

Ping Rate Bathy Applanix WC SS SN SNS Data Rate 

50 Hz ✓ ✓ ✗ ✗ ✗ ✗ 5 Mbps 

50 Hz ✓ ✓ ✓ ✓ ✗ ✗ 13 Mbps 

50 Hz ✓ ✓ ✓ ✓ ✓ ✗ 13 Mbps 

50 Hz ✓ ✓ ✗ ✗ ✗ ✓ 11 Mbps 

 

4.10 Interfacing with Multiple Computers 

It may be necessary to have more than one PC to communicate with the sonar, e.g. one computer 
to configure and control the sonar system and a second, more computationally resourceful PC, for 
running acquisition software such as HYPACK or QINSy. To achieve this, two additional hardware 
items are required: 
 

1. A Network Switch 
2. An Ethernet cable for each PC connecting to the sonar 

 

 
 

Step 1. Connect the sonar to the Ethernet switch and then the controlling PC to the switch. Configure the 
network settings on the controlling PC as described in Section 4.2, noting the IP address of this 
computer. Install the WBMS GUI and configure it as described above. Power on the sonar and 
launch the WBMS GUI. 

 

Step 2. Connect the second PC to the Ethernet switch. Ensure that the IP address of this PC does not 
conflict with those of the other systems. From here, the user has at least two options for interfacing 
with the sonar. First, the user may communicate from a second instance of the GUI, running on this 
PC. If configured properly, the IP address of the first PC should appear online in the Connection 
Dialog and users may connect to it as usual. Another option is to open the acquisition software, e.g. 
HYPACK sonar settings (see Appendix), initialize the program to query the IP address of the first 
PC. This configures the acquisition program to request data from the GUI running in the first PC. 

 

 

Network 
Switch 
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 Theory of Operation 

To operate the sonar effectively, users should be aware of certain basic principles of sonar signal 
processing. Possessing this knowledge gives users confidence to adjust the settings for optimal 
bathymetry and backscatter data collection, as well as aiding troubleshooting. 

5.1 Range vs. Bandwidth 

For higher quality bottom detection, the bandwidth should be maximized. The NORBIT WBMS 
implements a bandwidth of 80kHz throughout its operational range. Only the sweep time is adjusted 
in shallow waters. If in manual mode and operating in shallow waters, select FM Short Range mode 
to maximize ping rate. 

 
The NORBIT WBMS has been tested to 175m using 80kHz bandwidth. It is recommended that for 
most scenarios, users select the Auto option under Tx pulse settings. 

5.2 Bottom Detection 

The WBMS seamlessly utilizes three methods for bottom detection: 
 

▪ Amplitude 
▪ Phase 
▪ Weighted Blend 

 
Amplitude based detection is most accurate when the reflecting area is close to perpendicular to the 
beams. Phase based detection is most accurate when the reflecting area is at an angle to the beam. 
 
Thick lines show high emphasis on amplitude detection. Thin lines show high emphasis on phase 
detection. 
 
The WBMS automatically weights the amplitude and phase detection to give a seamless transition 
between the two at any area of the swath. This means that there are no predefined beams for 
amplitude, phase or blend. 
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5.3 STX (Steerable Transmitter) Usage  

The NORBIT STX is a steerable projector system that allows the transmit beam to be directed 
forward 10° and aft 10°, in a scanning pattern, along the vessel track. This scanning allows the 
system to ensonify areas that otherwise would not be, such as behind pilings. This functionality aids 
inspection surveys by giving a more complete picture of the survey area or target. 

 
When scanning is activated, the STX begins steering the transmit beam. Each step-in angle occurs 
with each ping. The time to complete a full fore/aft scan depends on the current ping rate, for 
example a ping rate of 20Hz, and a step size of 20, means 1 second per scan. For this reason, it is 
not recommended, for most applications, to have a step size of more than 20. For best results it is 
advised that the speed be kept as slow as is safely possible. In addition, it is recommended that two 
passes be performed: one pass as close as is safely possible to the structure, and a second pass 
slightly further away. This ensures that maximum coverage is achieved.  
 
The STX can also be used to capture additional details on complex structures on the seafloor, such 
as shipwrecks. Steering the transmit beam allows multiple hits, at various angles, on the target 
during a single pass. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

⚠ 
 

NOTE: Larger STX step sizes 

For most applications it is recommended to not exceed a step size of 20. In 
special cases, the step size can be increased up to 120. Contact NOTBIT 
support for further information and guidance.  
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 Survey Calibrations & Checks 

Before starting a survey (or during longer surveys) it is best practice to regularly check the 
performance and alignment of the sonar system. The following procedures are vital in maintaining 
quality control of depth measurements.  
 

6.1 Patch Test 

The Patch test resolves small misalignments between the sonar and the navigational system. Failure 
to not resolve these misalignments results in inaccurate depth measurements. A patch test is 
performed by running a series of reciprocal lines at varying speeds, depths and bottom terrain. A 
patch test should be performed over an area with a slope or prominent features. It is recommended 
that a patch test be performed whenever the sonar is re-mounted, repositioned, or has been 
displaced in any way.  
 
There are four tests that must be run for a patch test: latency, roll, pitch and Yaw. For best results, 
patch tests should be carried out when conditions are calm and vessel motion is at a minimum. It is 
important to have good vessel handling as the reciprocal lines need to be as close possible. Deeper 
water is preferred as the misalignment angles will be more apparent. Positioning should, at a 
minimum, be SBAS corrected. However, it is strongly recommended that RTK corrections be used 
as positional errors will decrease the repeatability of patch test measurements. For processing patch 
tests refer to the manual of the chosen acquisition or processing software. 
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6.2 Bar Check 

The bar check is a simple test that is used to verify that the draft corrections are holding constant. 
Periodic bar checks will help ensure that the system is stable and help account for changes in vessel 
loading. Bar checks are typically carried out using the Nadir beams to reduce the influence of ray 
bending due to sound velocity changes.  
 
For best bar check results, NORBIT recommends that the WBMS be set up with the following 
configuration:  
 

• Set Adaptive Gates to Off 

• Set ping rate to Fixed 3 Hz 
 

To conduct a bar check, an apparatus, that will reflect sound, must be lowered below the sonar to a 
known water depth. When the object becomes visible on the GUI a depth reading should be taken. 
This raw reading will be the depth below sonar head. The measurement should be corrected for the 
predefined draft of the sonar. For example, if the bar depth is 3m and the sonar head has a draft of 
1m the depth below sonar head will be 2m and when the 1m draft is accounted for the multibeam 
measured depth will match the bar depth. If the corrected depth does not match the bar depth further 
investigation may be warranted. 
 
A bar check apparatus can be made from a metal plate secured so it will hang level in the water. 
The depth of the plate is measured from the face. 
 

 

 

6.3 Surface Sound Speed Verification 

It is good practice to periodically verify the reading from the surface sound speed probe. This can 
be completed by comparing the readings from the surface probe to the reading from another sound 
velocity probe. If comparing to a sound velocity cast be sure to select a reading that is as close to 
the draft of the sonar as possible. It should be expected that the two readings be within 1m/s of each 
other. Should this not be the case further investigations may be warranted.   
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6.4 GNSS Independent Plate Check  

To ensure that all systems are operating properly and to verify offsets a 
Seahorse plate check was performed. The plate check consists of a metal 
plate attached to a fiberglass survey rod approximately 1m from the bottom 
of the rod. 
 
The rod is then extended and an independent GNSS rover antenna is placed 
at the top. The measurement from the GNSS antenna to the plate is taken 
and placed as the antenna height in the rover. The rod with the attached 
plate and GNSS antenna is lowered into the water so that the plate is visible 
within the sonar wedge. 
 
At the same time, GNSS measurements are taken from the rover and 
NORBIT data is recorded. The elevation of the rover shots and the final 
processed elevation of the soundings is then compared. If all sonar 
equipment is functioning properly and the offsets have been measured 
correctly then the final difference should be within 1-2cm and often better. 
 
The elevation of the plate, determined by the GNSS rover, can use the same 
base station as the NORBIT. However, using a different base station can 
add another level of independence from the sonar system. This can even 
help check that the base station you are using for the sonar is sending out 
the proper corrections.     

  

Plate 
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 Dual Head Configuration 

The WBMS systems provide high-resolution data in single-head mode. However, for shallow water 
applications where survey speed and efficiency need to be maximized, NORBIT provides a dual 
head solution that is extremely simple to set up and use. Especially in shallow waters, NORBIT’s 
dual head solution will yield swath coverage of up to 25 times water depth enabling surveyors to 
collect data very quickly and efficiently. Alternatively, two heads may be employed in downward 
looking orientation where one head is mechanically or electronically pitch steered for a multi-ping 
operation for increased along track sounding density.   
 
If a SIU-I-NAV (an integrated SIU, part no. 29028) is used, the secondary sonar can be connected 
to the same SIU via the auxiliary port. For SIU versions 
29028-4 and older, the power supply unit will require an 
upgrade to power two sonars. Please contact NORBIT if you 
have questions about upgrading your system for dual-head 
readiness.  
 
However, if two SIU-I (stand-alone SIU, part no. 29024) are 
used with a third party IMU, the primary sonar should 
connect to one SIU and the other sonar should connect to 
the second. Please note that if two SIU-I are used, timing in 
the form of a ZDA message and PPS over BNC must be 
supplied to both sonars. In addition, a TTL sync cable must 
be used between the two SIUs contact NORBIT support if 
you require this cable.  
 
To set up a dual-head system the sonars can be mounted on a dual-head bracket, sold separately 
by NORBIT. Please refer to the Dual Head Bracket section for a detailed schematic or contact 
NORBIT Support for more information. Alternatively, each sonar can be attached to a single-head 
bracket and mounted over each side of the boat. While this configuration may be more difficult to 
implement than utilizing a dual-head bracket, the wider separation will provide additional coverage. 
 
 

⚠ 

NOTE:  Dual Head Offsets 

When setting up an iWBMS in a dual head configuration IMU rotations and 
offsets will change. For further information on this please refer to the 
NORBIT tilted sonar technical note (document TN-190018) and/or the 
NORBIT Dual Head Quick Start Guide. If you do not have this document, 
please contact NORBIT support. 
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7.1 Installation Guide 

The following guide provides instructions to set up a dual-head system. 
 

1. Bracket and Mount: Decide whether to use a dual-head bracket (sold separately) or two 
single head brackets mounted over the side of the boat. Make an installation plan as 
recommended in Section 2.5.1. Attach sonars to the desired bracket(s) and follow 
installation plan.  

2. Power: If a SIU-I-NAV is used, it must be supplied with 24VDC. If two (stand-alone) SIU-
I are used, each will need 12VDC. The standard power brick provided with a single head 
system does not provide enough power for a dual head configuration. Please contact 
NORBIT support should you require a larger power supply.  

3. Antennas: As with the single-head, install antennas as recommended in 2.8 
4. Cables: Secure, direct and connect all cables to the SIU, ideally located next to the 

acquisition and control computer. The sonar cable of the 
second system can plug into the Aux port of an iSIU. 

5. SIU & PC: Connect the SIU to the control and acquisition 
PC via ethernet. Before powering the sonar set the IP 
address of the PC to 192.168.53.XXX where XXX can be 
any number from 101 to 255 except 100 which is reserved 
for the GNSS/INS or the last two digits of the sonar serial 
number; set the subnet mask to 255.255.255.0.  

6. GUI: Install the WBMS GUI and, with the SIU powered 
on, run the GUI to detect and communicate with the 
sonars. On the Connection Dialog, select the two 
sonars and select the Primary sonar. Click Connect. The 
example on this page shows an instance where the GUI 
detects two sonars (indicated by green LED) and has the 
IP address of a previously used, but disconnected system 
(indicated by red LED). In this example, the user must 
select the two detected systems, then check the Primary 
selection on the desired system, then select Connect.   

7. Sonar Controls: Once connected, two swaths appear in 
the main GUI display with the primary sonar appearing on 
the left, as shown in the example. Thus, visualization is 
more intuitive if the primary sonar is installed on the port side. The primary and secondary 
swaths are labelled on the display as such. If side scan is enabled, the image displayed 
is that from the two sonar systems combined. Adjust sonar parameters as needed and 
start collecting data. Any changes made to the sonar settings menu apply to both systems. 
The controls for dual head remain the same as for single head. For more detailed 
explanations of all sonar functions and controls, please refer to section 4.6. It is highly 
recommended that users change the sonar Tx bandwidth to 40kHz (for each sonar) since 
they are optimized for a total bandwidth of 80kHz. 

 
 

⚠ 

NOTE:  Port Number Assignments 

In the acquisition software, the port number is 7000 for primary and 7001 for 
secondary, by default. The secondary port is always one greater than the 
primary. Some software packages give the option to select one head as 
primary and one as secondary. In this case both heads will be primary. 
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7.2 Frequency Separation 

For dual head sonar operation, the transmit frequencies of the two sonars must not overlap. When 
2 sonars are selected the NORBIT GUI automatically applies a frequency separation to the sonars. 
This separation is determined in the following way. When a center frequency is selected that GUI 
will choose a bandwidth, by default, of 40kHz. For instance, when 400kHz is used with the default 
bandwidth of 40kHz, the sonars ping through a total frequency range of 360kHz-440kHz, with one 
sonar pinging a range of 360kHz to 400kHz, and the second sonar pinging from 400kHz to 440kHz. 
This allows the sonars to ping in sync without interference.   
 
If you wish to change the frequency spread, you can do this by simply adjusting the bandwidth. The 
closer you put the bandwidth to 80kHz the more frequency overlap will occur. If you desire to operate 
the sonars individually you can simply unlink them. To control a sonar, click on the wedge associated 
with the desired sonar and adjust the settings as required. 
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 Optional Enhancements 

While the integrated family of NORBIT systems are already highly capable, NORBIT offers additional 
products that further enhance their capability. These optional enhancements can be easily integrated 
into the existing iWBMS(x) systems. For additional information, please contact NORBIT. 

8.1 Obstacle Avoidance Forward Looking Sonar (FLS) 

NORBIT’s FLS is a wide beam angle sonar that can be mounted pointing up and looking forward. 
This configuration was developed to aid surveyors in obstacle avoidance and marine feature 
monitoring in especially difficult navigational conditions. The additional sonar is plugged into the 
AUX port on the SIU, simplifying the hardware setup. Please contact NORBIT to learn more about 
the FLS.  

8.2 Integrated Topographic LiDAR (iLiDAR) 

For users that require topographic data to be acquired in 
conjunction with multibeam data, NORBIT offers the iLiDAR. The 
iLiDAR plugs into the AUX port of the iSIU. Like the iWBMS 
systems, all timing and power is handled internally, eliminating the 
need for additional cables. The LiDAR is as close to plug and play 
as possible. The LiDAR uses 16 beams allowing for up to 300,000 
points/sec to be collected simultaneously with multibeam data, 
while still only requiring a single network cable from the SIU to the 
acquisition PC.  

8.3 Carbon Fiber Mounting Pole (PORTUS) 

For users that frequently travel with their system and utilize vessels of opportunity, NORBIT offers 
the PORTUS Pole. This carbon fiber mount easily packs down into one hard ski case and can be 
checked with your NORBIT system onto nearly any commercial flight. The PORTUS easily mounts 
to nearly any small vessel of opportunity, and with known dimensions there is no need for the 
surveyor to worry about calculating offsets.  

 

   
 

 Troubleshooting  

9.1 Troubleshooting Tools 

For some troubleshooting, having the right tools greatly speed up the ability to solve the issue. For 
NORBIT systems, methods for interrogating serial and network connections are two of the most 
useful software tools. 
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For interrogating serial data, it is recommended to use 3rd party software. NORBIT recommends 
using PuTTY, a free 3rd party telnet and SSH implementation for Windows. See section 9.1.1 for 
instructions on using PuTTY  
 
For Network Troubleshooting: The most common tool needed for the NORBIT is the “ping” 
command executed using Windows command prompt. This command pings or checks the input IP 
address and tests if a connection is present. This is useful for verifying whether NORBIT is 
communicating with the PC and indicates whether the problem may be somewhere else down the 
line. Should further investigation be needed, Wireshark is a good networking troubleshooting tool 
and can be downloaded for free. For HYPACK, users Wireshark can be found in: C:\HYPACK 
2014\Support\Utilities\ 
 
To Use the Ping Command: Open Command Prompt window by typing cmd into the Windows 

search bar. In the command prompt type ping 192.168.53.XX. This example shows how to verify 

the connection of the sonar to the computer. Keep in mind that the last 2 digits correspond to the 
last 2 digits of the serial number of the unit in question. This also works for the internal Applanix INS 
by typing ping 192.168.53.100.  

 
To troubleshoot hardware issues, it is recommended that users have a digital multimeter on hand. 
Multimeters are inexpensive and can be purchased at most electrical or hardware stores. Please 
make sure that it includes a continuity test function. Some units have an audio indication for this test. 
The two most useful functions for troubleshooting sonars are the continuity test and voltage indicator. 
The continuity test helps identify broken cables or connections, while the voltage indicator helps 
identify power related issues. 

 Configuring PuTTY for Serial Interrogation 

Begin by changing the connection type to serial. Type in the relevant COM port number and 
expected baud rate, referred to as Speed in PuTTY. Once the connection parameters have been 
entered, click Open. 

 

 

 

 

 

 

 

 

 

 

 
PuTTY then opens a command-style window and displays any data incoming on the specified port. 
The example below shows several NMEA messages arriving on COM 4: 
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 Sonar Simulator 

For training and certain troubleshooting scenarios, NORBIT 
provides a sonar simulator that sends simulated data to the 
standard GUI. The simulator is currently only for sonar data 
and does not output simulated navigational data. 
 
The simulator can be started via the Connection Dialog. 
Press Start Simulator. Once started, highlight the bathy 
simulator on the sonar list and click Connect as you would 
do with a standard sonar. You may receive an incompatible 
firmware warning; ignore this and click Connect Anyway. 
 
To start the simulated sonar data, click the play button. The 
simulator data can be used in acquisition software for 
testing, training or troubleshooting purposes. The simulator 
does not output sound velocity, navigational or inertial data. 
Consequently, the simulated sonar data will not be time 
stamped. 
 
To close the simulator, simply shut down the GUI. If you 
wish to switch back to a real sonar, return to the Connection 
Dialog and select it.  

 
 
 
 
 
 

9.2 Symptoms & Suggested Actions 

Following is a table that should facilitate troubleshooting of common problems: 
 

Problem Possible Solutions 
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Cannot connect to the 
sonar 

• Verify the SIU is powered on  

• Check that cables connections are free from corrosion and are 
properly secured 

• Check for bent pins on sonar cable  

• Check for IP address conflicts. The network card on the PC should be 
configured to 192.168.53.XXX where XXX is neither 100 (INS) nor the 
sonar serial number. 

• If using a network switch, bypass the switch and connect directly to 
the computer to check for faults with the switch. 

• Reboot PC wait 30 seconds, then power-cycle the SIU. 

• Ping the sonar to check connection. 

• Try grounding the SIU 

WBMS is connected but no 
IMU data is coming in 

• Check cable connections and reseat if necessary  

• Check for bent sonar cable pins 

• Possible IP address conflict. Check network settings  

• Windows Firewall is preventing connection, allow POSView access 
through firewall. Can still be the problem if firewall is off. 

• Possible damages sonar cable 

• Try grounding the SIU 

WBMS GUI does not 
match description in this 
manual or software not 
performing as described in 
manual 

• Obtain the latest installation version from NORBIT support: 
subsea_support@NORBIT.com and install. 
 

IMU is connected but there 
is no sonar connected 

• Check cable connections reseat if necessary  

• Possible IP address conflict. Check network settings 

• The GUI and BathyProxy should be allowed in windows firewall.  

• Try grounding the sonar 

Surface SV sensor is not 
connected or is showing 
bad values 

• SV sensor is not tightly secured to the head leading to faulty 
connection; tighten up the SV probe to the head.  

• Trapped air bubbles are changing sound speed. Stop the vessel to 
allow bubbles to dissipate to see if reasonable values return. May 
need to adjust mounting to reduce bubble formation 

• Inspect the sensor for visible damage. Any distortion in the sensor 
may cause bad readings. 

• Check for foreign object stuck on sensor.   

 
Sonar display is freezing, 
and data packets are being 
dropped 

• May be due to heavy network traffic; run Task Manager to check if any 
unnecessary programs/processes are taking up excessive network 
bandwidth 

• Bad switch, hub or cable. Replace. 

• May need to manually update computer network card driver 

Network disconnection 
errors occur or data from 
sonar and/or IMU is dead 

• Check the sonar and/or IMU cables. Check that the connection at wet-
end is tight. If it has loosened then remove connection, clean threads 
at both male and female fittings and apply a very small amount of 
grease (O-Ring grease mentioned in this manual works well) then re-
tighten. If fingers are weak from cold, then use a tool but do not 
overtighten! 

Unable to get RTK 
correctors  

• Check COM port settings  

• Check cable connections  

• Verify IP address and mount point if using network solution 

• Check radio link 

• Try with Null Modem 

• Check on a different unit to see if data is legible 

mailto:subsea_support@norbit.com
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Soundings are being 
filtered out  

• Adaptive gates are on Narrow and may need to be changed to a wider 
setting 

• May need to turn adaptive gates off.  

Bottom detection quality is 
degraded 

• Check sonar head for marine biofouling. Clean barnacles off gently. 

• Check that sonar cable connectors are clean, dry and properly seated. 

Lower Gate is beyond 
expected depth but there is 
no bottom detected or 
soundings look like a large 
hump 

• Try lowering the upper gate closer to the expected bottom.  

Unable to get GAMS 
Calibration to lock in 

• Check antenna connections ensure that the antennas are plugged into 
the correct primary/secondary sockets.  

• Verify offset measurements 

• Reset POS to factory defaults and start configuration over 

• Area/Time may have bad GNSS. Relocate and/or wait for better 
GNSS window 

No GNSS Data in INS 
System  

• Check cables and ensure that connection is tight on the SIU and 
antennas 

• Make sure that the antennas provided with the kit are used. Other 
antennas may cause issues 

• Make sure antennas have clear view of the sky and not obstructed by 
metallic objects, etc. 

System status shows faults • Check that cables are secure and tight 

• Check for bent pins on the cable and SIU 

• Low quality power supplies may cause this issue. Change the power 
source to see if this fixes issue.  

• Possible damaged sonar cable.  

• Try grounding the SIU 

NovAtel Connect will not 
connect on port 3001 

• Connect on a different port 3002 or 3003 and 
apply FRESET and reload the batch file. 

 

NovAtel data not read in 
acquisition software or 
acquisition software 
crashes 

• Check that there is not port interference. Connect and acquisition 
software should not be connecting on the same port number.  

INS window in NovAtel 
connect displays no data or 
crashes connect when 
open 

• Update video drivers on computer.  

There is data in NORBIT 
GUI and INS GUI, but data 
is not coming into 
acquisition software 

• Ensure that both sets of firewalls (Private and Guest or public 
networks) are turned off.  

• Check to see if acquisition software has correct ports specified.  

There is no timing in the 
sonar. GUI timing line is 
red 

• Check pins on cable and in SIU. If a pin is bent VERY gently bend it 
back. *This may result in damage so do so at own liability* 

• If cable is good check that INS is outputting ZDA and PPS pulse 

• Besides the onboard GNSS cards, users can obtain reliable NTP 
timing from the QINSy time server. Another recommended source of 
external, free third-party timing server is Meinberg. Another option is 
to use the QINSy SNTP server, which does not require license. Open 
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QINSY, double-click SNTP Server – this should automatically start the 
server. If not, the user may have to change (UDP) port in the Options 
menu inside SNTP Server. Once server is running, go to the NORBIT 

GUI and go to Advanced > Options > Timing and Triggering, select 

NTP+PPS pos, select the proper IP and click Apply.  

“Sonar timing incorrect” 
pop-up window remains 
even after antennas pick 
up satellites 

• This may happen sometimes if the POS MV reboots slower than the 
sonar. You can manually close the pop-up window in this case. If 
sonar timing is incorrect, the timing row in the main GUI display will 
remain red.  

iWBMSc has incorrect 
heading after powering up 

• Restart the SIU. Make sure vessel has some motion during alignment 
process. See NovAtel section of this manual for further information.  

No NORBIT data in PDS or 
EIVA 

• Ensure that force push is checked under Connection settings in GUI.  

Smears appear in the 
snippets record 

• PC load is too high, and it is unable to properly process the high data 
load. Try reducing PC load by closing unused programs and non-
critical windows in the acquisition software. Older slower computers 
may not be able to handle the data load and a newer computer may 
need to be used.  

Text in GUI appears too 
cramped 

• In Windows, go to Change Display Settings, and change the Scale 
and Layout values; more specifically, change the value under 
“Change the size of text, apps, and other items” 

INS Logging light it Red or 
Orange 

• Open INS Setup Wizard and apply Factory defaults 

• Reboot PC 

• Turn off firewalls.  

9.3 SIU Grounding 

In some cases, the SIU may need to be grounded for proper operation. Some symptoms of possible 
grounding issues are, IMU failures, sonar boot up issues. If you do not see a grounding screw on 
the SIU, NORBIT advises that you use the BNC connection. To ground the system, find a BNC cable 
and break off the pin inside the connector. On the other end expose the ground shielding, using the 
outer braid of wires and crimp a connection to them (see below image). Connect the BNC connection 
to the SIU and the other end to either a metal part of the vessel or a wire that is in the water.  
 

 

9.4 Finding the Computer IP Address 

To find the IP address of the PC operating the NORBIT GUI, open command prompt from the 
Windows Start Menu and then type ipconfig and press enter. Then search for the IPv4 IP address.  

Depending on what type of connection is present, either look for the wired or wireless IPv4 address. 
Note, you may need to run command prompt with administrator rights (right-click and select Run as 
administrator).  
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9.5 Change Sonar IP Address 

Log onto the sonar with telnet. To do this, press Windows+R to open the Run dialog. Type cmd to 

open command prompt, then use the following commands: 
 

Telnet 192.168.53.XX (where XX is the last two digits of sonar wet-end serial number) 

 
Print to screen all u-boot parameters: 
 

fw_printenv 

 
Options: 
 

fw_printenv ip_addr (print to screen all ip_addr parameters) 

 
fw_setenv ip_fallback 192.168.53.99 (sets IP to 99 if no DHCP server is on the 

network) 
 

fw_setenv ip_addr 192.168.53.99 (sets static IP to 99 regardless of DHCP) 

 

9.6 Cable Covers 

The sonar cables (and IMU cables for the integrated versions) include a protective cap affixed to the 
cable with an adjustable length cable. The length may be adjusted by grabbing one of the small 
collars and pulling on the cable. 

9.7 Data Quality Control Checklist 

The manual details procedures for optimizing NORBIT sonar performance. However, if some simple 
steps are skipped or not followed closely users may encounter data degradation. This section 
provides a brief checklist and options to enhance data quality. 
 
Checklist to improve data quality: 
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1. Review Hardware Installation: Ensure that the two antennas remain fixed in place 

relative to each other; otherwise there heading errors are present. Similarly, the position 
of the primary antenna relative to the IMU should not change; such motion will cause 
position errors in soundings. 

2. Primary Antenna: Ensure that the primary antenna is closest to the IMU and connected 
to the correct port. 

3. Offsets: Measure offsets correctly to the nearest 1cm or better, and check that the signs 
are correct. 

4. Alignment: Ensure that the sonar (and IMU if separate) is closely aligned with the vessel 
centerline (keel). Agreement to within ±0.5° is ideal if the sonar and IMU are within 5m 
from one another. 

5. Center of Rotation: If the IMU is not mounted at the CoR, it is important that the 
processing software corrects for vertical motion using the CoR offset lever arm with roll 
and/or pitch tilt as the heave sensor is less accurate than this. The heave should only be 
used to determine the vertical displacement of the entire survey platform. 

6. GNSS Corrections: Only Narrow Lane RTK is suitable for RTK tides. Position errors 
increase with distance from the base station. DGNSS is accurate only to about 60cm 
horizontally. Ideally use a post-processed kinematic solution. There are different options 
depending on the GNSS equipment used during survey.  

7. Surface Sound Speed: This may differ greatly in the upper 1m surface layer of the water 
column. If this difference exists (check with a profiler) then, if possible, lower the sonar 
below this layer boundary, but not so deep that the sonar pole cannot be controlled. 
Generally, 1m is the limit. Compare surface sound speed from the WBMS with the sound 
velocity profile at the draft depth. These speeds should agree within 1-2m/s. 

8. Sound Speed Profiles: Should be taken as often as the changing conditions dictate. For 
instance, once per day may be suitable in non-tidal areas of a river or lake while once 
every 500m, or 1-2 hours, may be required for some regions where water temperatures 
vary greatly. 

9. Patch Test: Review multibeam roll, pitch, yaw and latency offset values. Repeat 
measurements as and when required. Generally, during a single installation, roll should 
not vary by more than ±0.02°, pitch by ±0.1° and heading by ±0.5°. Conduct a patch test 
every time the sonar and IMU are moved. 

10. Swath Angle: Bathymetric soundings are most accurate if they are within a ±70° area 
from nadir (depending on water depth), or wider if the beam footprint and incidence angle 
are very small, e.g. when the swath is perpendicular to a steep shoreline sloping up from 
nadir. Soundings sloping down from nadir have a large footprint and incidence angle. It is 
always better to ‘look’ up a slope than down one and therefore survey lines should 
generally be parallel to the bottom contour. 

9.8 Sonar System Diagnosis 

In case of technical difficulties with the iWBMS system, users should refer to the guidelines below. 
If possible, please have TeamViewer (or similar remote desktop control application of choice) 
installed and ready to run, to allow NORBIT Support to control the system remotely. This 
section explains how to diagnose sonar-related issues, while the following section discusses 
Applanix-related problems. 
 
In case the sonar starts to function erratically, NORBIT support will advise the user to perform 
diagnostic checks, including, but not limited to the following: 
 

1. Verify IP Address of Acquisition/Control PC: Should be 192.168.53.XXX, with XXX 
being greater than 100 and less than 255. The system subnet mask should be 
255.255.255.0. 

2. Verify Power Supply: If WBMS GUI fails to connect to or detect hardware, first check if 
the system is powered on. If so, check the power supply voltage with a voltmeter. Also, 
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depending on the power source, check the battery/inverter for failure. Check the sonar 
SIU LED and power supply to the SIU; a faulty power supply prevents proper connection 
to sonar, and/or IMU faults. If power is <12V or >28V the power LED will blink at 5Hz. It 
may be necessary to employ an alternative, preferably known power source to test the 
system, e.g. power the sonar from a wall outlet or fully charged battery. If this step is not 
possible, go to the next step. 

3. Command Line Ping: To test connectivity to the sonar, open Windows Command Prompt 
and type ping 192.168.53.XX (XX being the last 2 digits of the sonar serial number). 

This indicates whether the sonar is detectable by the acquisition PC 
4. Factory Reset: If the sonar is detected in the GUI, go to Connection > Sonar 

Connection and click Set Sonar Factory Defaults. Wait a few minutes to see if the 
connection is re-established. 

5. Socket Pins: Turn off power and check all cable and SIU sockets for bent pins. 
6. NORBIT GUI Recording: For issues visible in the GUI display, send NORBIT Support a 

small recording that shows an example of the problem. Please enable water column 
(“View WC”) in the NORBIT GUI and include it in the recorded display.  

7. NORBIT Logs: If possible, send NORBIT Support the following information in an email or 
document:  

a. In the GUI, go to Connection > Sonar Connection > Log. Select Retrieve Logs, then 
Copy to Clipboard, and paste the contents to a document or email. Do the same for 
System Log. 

b. Go to Connection > Sonar Connection > Info, select Copy to Clipboard and paste the 
contents to a document or email and send it to NORBIT Support. 
  

   
 

c. Should the user see other error messages, whether in Windows or the GUI, screenshots 
should be taken, saved, and emailed to NORBIT support for reference. 
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9.9 Applanix INS Diagnosis 

1. Check Timing: If there are no timing issues ignore 
steps 1-3. If timing is incorrect, check the Primary and 
Secondary GNSS indicators at the top of the GUI and 
go to INS Tools > Sky Plot to check if any satellites are 
detected, and if so, to what level of precision.  

2. Confirm LED Status: Check PPS LED on the SIU. If 
functioning correctly, it should blink at 1Hz. If satellites 
are detected but the PPS LED is not blinking at 1Hz, 
open POSView and check COM4 settings to check that it is outputting NMEA ZDA. For 
LED indicator statuses, refer to the table below. 

 

PPS LED Status 

Orange, blinking at 1Hz Sync good 

Orange, blinking at 5Hz No sync, NMEA missing 

Orange, steady No sync, PPS missing 

Off No sync, NMEA and PPS missing 

 
3. Inspect Pins: PPS LED is blinking at 1Hz, power off system and very carefully check for 

bent IMU cable and SIU socket pins. If you find bent pins, contact NORBIT Support for 
immediate instructions on how to fix them. If possible, please send pictures of the bent 
pins to NORBIT Support. Also check cable and SIU sockets for dirt and other unwanted 
materials that may interfere with the signal. 

4. Physical Installation: For issues such as motion artefacts, let NORBIT support know if 
any changes were made to the physical setup (e.g. if sonar/antenna pole was moved). If 
possible, send pictures of the mounting configuration to NORBIT. The goal is to rule out 
any wobble in the physical setup. Also, ensure that primary and secondary antennas are 
no more than 2m apart. If they are not, heading accuracy may be compromised.    

5. Check for Damaged Cable: If the check in #3 also passes, try gently turning and twisting 
the sonar cable to see if a damaged cable is causing the issues. If it is, the symptom may 
be reproduced by bending the cable at or near the damaged area. 

6. Data Rate: In case of missing RTK signal: 
a. If using NTRIP, check the internet connection and the correct COM port to use in Windows 

Device Manager. Verify NTRIP login credentials, IP address, etc. Check Corrector type 
and verify that baud rates specified in NTRIP match baud rates in the NORBIT GUI INS 
Setup Wizard.  

b. If using a rover, if no RTK signals are received, check that the radio is transmitting, and 
that the receiver is tuned to the correct frequency and is functional. Verify that baud rates 
and corrector types match. 

7. Screenshots: If the sonar is detected but the IMU is not, or an IMU Failure error is 
displayed, check cable sockets for bent pins. If all pins look fine, power the system on, 
open POSView and send screenshots of the main POSView display, as well as the 
following: 

 
View > IMU Data   

 

Diagnostics > IMU 

 

 
 
 



 
 
 
 

 

10.4.3 User Manual                                       Contents April 17, 2020 
Firmware: 5.2.1   Page 79 of 142 

 

View > Faults 

 
 

View > Statistics 

 
 
 

 
8. Resistance/Continuity Test: If the IMU remains unresponsive or POSView shows IMU 

Failure, perform the “resistance test” to check the status of circuit components. A 
multimeter is required for the measurement of resistances across nine pairs of sonar 
socket pins. The illustration below shows the socket diagram and corresponding 
resistance when functioning correctly. Please measure the resistances and send the 
results to NORBIT Support. 
 

 
 

9. Factory Reset: For users of iWBMS(x) with Applanix inertial sensors, and NORBIT GUI 
10.2 or later, if errors pertaining to the INS persist, attempt a Factory Reset. Go to INS 
Tools > INS Setup Wizard and select Factory. Then close the window.  

10. Applanix/POSPac Recording: For motion, heading or position artefacts in the data, 
please send NORBIT Support a *.000 file for further diagnosis and troubleshooting. 
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 Basic Acquisition Software Setup 

10.1 HYPACK Setup for WBMS, iWBMS, iWBMSh, iWBMSe & iWBMSc 

For sensors not supplied by NORBIT please contact vendor for integration instructions. The 
following sections show only one of many possible methods for configuring HYPACK 2017a for the 
NORBIT sonars. As with many sensor suite setups, this is certainly not the only method. The 
examples assume that the INS reference is collocated with the sonar reference location. 

 Offsets 

By default, integrated NORBIT systems output all sonar and navigation data at the WBMS Reference 
Point (refer to the Offsets section for more details). Therefore, each device in HYPACK requires the 
same identical offset, that is the offset from Center of Rotation to WBMS Reference Point, assuming 
the CoR is chosen as the HYPACK reference point. If the optional iLiDAR is installed, this offset 
must be separately measured and applied. 
 
Note that the HYPACK sign convention uses +Forward, +Starboard, and +Down. Incorrect entry 
of the sign may corrupt data. If depths need to be reported relative to the water level, please move 
the CoR height up/down to the appropriate level. Perform a draft or bar check to verify these values. 

 
 

⚠ 

CAUTION:  For Integrated Systems, Sonar and INS Share Same Offset 

Offsets from CoR are required if the INS is setup as recommended in this 
manual. Referencing data to the CoR reduces heave inaccuracies by 
replacing the heave data with attitude-induced lever arm corrections. 

 
 

About the COR: The COR, for larger commercial vessels, is documented in the vessel design plans. 
For other vessels, this point at which the vessel’s roll and pitch axes intersect need to be determined. 
This is difficult to measure as the vessel CoR may change from day to day, and even during the day. 
Generally, choose a CoR location that is about ¾ distance from bow to stern, centered on the keel, 
and located at approximately water level. Especially for smaller vessels, the CoR moves depending 
on fuel stowage and even distribution of personnel body weight. For example, two persons sitting 
on the starboard rail of a 6m craft will move the CoR from the keel centerline a distance towards the 
starboard rail. Choose a location and attempt to keep the weight distribution constant throughout the 
survey. If in doubt, take the boat to open water and measure its motion while passing over waves in 
different directions. 
 
This example configuration places the INS reference at the sonar reference, i.e. the INS was 
configured to output values to the WBMS Reference Point. If users want to base bathymetric 
measurements referenced to the water level, the only other offset required is a water level correction. 
This allows the application of tide station water level corrections if required. The water level 
correction involves translating the CoR up/down to the water level and confirmed by a bar check. 
 
The offsets shown will be different for every vessel. For this example, HYPACK2017 is used.  
 
HYPACK 2017 configuration combines both HYPACK Hardware and HYSWEEP hardware into one 
interface. However, both sections must still be configured with the same drivers as in previous 
versions. 
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 HYPACK Setup for WBMS, iWBMS, iWBMSh & iWBMSe 

 
Step 1. Enable HYSWEEP Survey 

Check Include under HYSWEEP Survey. This allows devices to be added for multibeam surveys.   
 

 
 

Step 2. Define Boat 
Select Boat and give it a name. For more intuitive visualization, add a tracking point, preferably to 
the sonar reference point (for standard installations). Edit Vessel Shape as appropriate.  
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Step 3. Configure Position and Heading Device 
In Survey Devices, add the Applanix POS M/V Network device and configure it as shown below.  
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Step 4. Configure HYSWEEP Interface 
Then add, and configure, HYSWEEP Interface, checking only the Depth function under Functions: 
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Step 5. Configure Motion Device 
In HYSWEEP Survey, add the Applanix POS/MV Network device and configure it as shown below: 
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Step 6. Configure Multibeam Device 

Next, go to HYSWEEP Survey and select NORBIT WBMS as shown below. In WBMS Setup, 
select Sidescan Recording for recording Sidescan only, or Snippet SS Recording for Snippet-
Sidescan, or Snippet Recording for logging Snippets. If Snippet data is requested, users must 
also select Log Datagrams. Note that the bathymetry data automatically includes beam intensity 
values at the bottom detection point, which provides coarse backscatter, separate from side scan 
and snippets. 
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 HYPACK Setup for iWBMSc 

The procedure for iWBMSc users is the same as described in the previous section, except for the 
following differences in steps 3 and 5: 
 

Step 3. Configure Position and Heading Device 
In Survey Devices, add the Novatel SPAN-SE device and configure it as shown below.  
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Step 5. Configure Motion Device 
In HYSWEEP Survey, add the Novatel SPAN device and configure it as shown below: 
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10.2 QINSy Setup for WBMS, iWBMS, iWBMSh, iWBMSe & iWBMSc 

For sensors not supplied by NORBIT, please contact the vendor for integration instructions. The 
following sections show recommended configurations of QINSy v8.18 for all NORBIT sonars. The 
examples assume that the INS reference is collocated with the sonar reference. 

 
iWBMSc users must configure the MarineSPAN output records to log the following: 
 

LOG ICOM2 INSPVAA ONTIME 0.05 

LOG ICOM2 TIMEA ONTIME 1 

LOG ICOM2 BESTPOSA ONTIME 0.2 

LOG ICOM2 HEAVEA ONNEW 

 
For information on how to configure the NovAtel Connect software please refer to section Error! R
eference source not found.. 

 Offsets 

By default, integrated NORBIT systems output all sonar and navigation data at the WBMS Reference 
Point (refer to the Offsets section for more details). Therefore, each system in the QINSy database 
requires the same identical offset, that is the offset from Center of Rotation to WBMS Reference 
Point, assuming the CoR is chosen as the QINSy reference point. If the optional iLiDAR is installed, 
this offset must be separately measured and applied. 
 
Note that the QINSy sign convention uses Y+ Forward, X+ Starboard, and Z+ Up. This is not the 
same as the integrated Applanix systems on NORBIT sonars. Incorrect entry of the sign may corrupt 
data. If depths need to be reported relative to the water level, please move the CoR height up/down 
to the appropriate level. Perform a draft or bar check to verify these values. 
 
 

⚠ 

CAUTION:  For Integrated Systems, Sonar and INS Share Same Offset 

Offsets from CoR are required if the INS is setup as recommended in this 
manual. Referencing data to the CoR reduces heave inaccuracies by 
replacing the heave data with attitude-induced lever arm corrections. 

 
 

About the COR: The COR, for larger commercial vessels, is documented in the vessel design plans. 
For other vessels, this point at which the vessel’s roll and pitch axes intersect need to be determined. 
This is difficult to measure as the vessel CoR may change from day to day, and even during the day. 
Generally, choose a CoR location that is about ¾ distance from bow to stern, centered on the keel, 
and located at approximately water level. Especially for smaller vessels, the CoR moves depending 
on fuel stowage and even distribution of personnel body weight. For example, two persons sitting 
on the starboard rail of a 6m craft will move the CoR from the keel centerline a distance towards the 
starboard rail. Choose a location and attempt to keep the weight distribution constant throughout the 
survey. If in doubt, take the boat to open water and measure its motion while passing over waves in 
different directions. 
 
This example configuration places the INS reference at the sonar reference, i.e. the INS was 
configured to output values to the sonar reference location. If users want to base bathymetric 
measurements referenced to the water level, the only other offset required is a water level correction. 
This allows the application of tide station water level corrections if required. The water level 
correction involves translating the CoR up/down to the water level and confirmed by a bar check. 
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 Database Setup for WBMS, iWBMS, iWBMSh & iWBMSe 

QINSy structures all data in a native database format. All data and hardware settings including 
offsets are saved to a database file. The setup locates all sensors relative to an object, usually the 
survey vessel. The offsets from the object to the system (vessel) CoR are entered as a node. 
 

 
 

Step 1. Configure Geodesy 
To start creating the database, go to QINSy > Setup > New Database. Go through and fill out the 
relevant Datum Parameters fields, i.e. specify the project geodesy.  
 

Step 2. Object Definition 
Complete all relevant fields in the Object Definition section. This allows users to specify the shape 
of the vessel, location of the vessel/object reference point, etc. 
 

   
 

Should the user desire a vessel shape, it can be created and previewed in this section. 
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Step 3. Add Multibeam System 
Once the project geodesy and vessel shape have been specified, instruments/sensors can now be 
added for data acquisition. The WBMS is the first instrument that is added.  

 
The system requires a name and type. The name can be user defined, e.g. NORBIT and the system 
type, chosen from the drop-down menu is Multibeam Echosounder. Under socket settings select 
the Reson SeaBat 7k (TCP/Network) driver. The port number is 7000 and the IP address is 
127.0.0.1. Then click Next. 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
In the next window, Raw Data Recording, for standard bathymetric data collection select NORBIT 
under System, None under Packet Storage, Water Column and Snippets. Note that the bathymetry 
data automatically includes beam intensity values at the bottom detection point, which provides 
coarse backscatter, separate from side scan and snippets. 
 

Step 4. Configure Snippets and/or Water Column Recording (Optional) 
To collect water column, users must select the 7042 (Compressed) option. To collect snippets but 
no water column, configure the system as shown below on the left; for snippets and water column 
see image on the right. Once configured, click Next. 
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Step 5. Enter Offset to WBMS Reference Point 
Offsets are specified in the Multibeam Echosounder Parameters window. Click on the + sign and 
create a new node called WBMS. Patch test values (roll, pitch and heading) may be entered if known. 
Enter 512 under max beams per ping. 
 

               
  
NORBIT recommends that users keep the default values in the Echosounder Accuracy Parameters 
and Multibeam Echosounder Corrections. Click Finish. 
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Step 6. Add Side Scan System (Optional) 
After completing the previous step, the user is prompted to configure 
additional related systems. If side scan data is required, add it now. 
 
To set up the NORBIT side scan in QINSy configure the pages as shown 
below. A port and starboard channel must be added and specify the 
frequency. Items marked with an asterisk (*) will not impact the data and 
are only for record keeping. Click Finish when done. 

 

 

   
 

Step 7. Add Pitch/Roll/Heave System 
From the Database Setup window, right-click System, click New System and add a Pitch/Roll/Heave 
sensor. Please note that for Applanix POS MV systems, the sign convention is positive downwards: 
 

   
 

 
 



 
 
 
 

 

10.4.3 User Manual                                       Contents April 17, 2020 
Firmware: 5.2.1   Page 96 of 142 

 

 
Step 8. Add Gyro Compass System 

Repeat the previous step to add a new system, but this time add a Gyro Compass: 
 

   
 

Step 9. Add Position Navigation System 
Repeat the previous step to add a new system, but this time add a Position Navigation System. The 
Horizontal and Vertical datum will obviously depend on project specifications. 
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Step 10. Output Quality Information (Optional) 

To configure the iWBMS, iWBMSh or iWBMSe (with Applanix) to output quality information, add a 
Miscellaneous system as per below: 
 

   
 

Step 11. Add Time Synchronization System 
A time synchronization system must be added. Use binary group 7 without a PPS box. 
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 Database Setup for iWBMSc 

The setup procedure is generally the same for iWBMSc users, but with the following differences in 
Steps 7-10. 

 
Step 7. Add Pitch/Roll/Heave System 

iWBMSc users must configure the Pitch/Roll/Heave Sensor as follows: 
 

   
 

Step 8. Add Gyro Compass System 
iWBMSc users with the NovAtel INS should configure the Gyro as follows: 
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Step 9. Add Position Navigation System 
iWBMSc users should configure the system as shown below: 
 

  
 

Step 10. Output Quality Information (Optional) 
iWBMSc users must configure the NovAtel quality output as follows: 
 

   

 Known Issues 

1. If QINSy crashes during data acquisition, it may fail to close the SeaBat driver. If this is the case 
users may have to close the driver manually. To do so, open Windows Task Manager and close 
DrvSeabat7k.exe.  

2. The QINSy dongle may block a COM port after a crash. This can also be checked by going into 
Task Manager with QINSy closed and the USB dongle removed. Look for sntlkeyssrvr.exe 
and/or sntlsrtsrvr.exe. Close both from Task Manager and try again. 

3. Rates in the observation physics display for the NORBIT are incorrect. This may lead users to 
think that sonar is not pinging properly. This is not the case. 
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10.3 PDS Setup for WBMS, iWBMS, iWBMSh & iWBMSe 

The WBMS GUI Version 10 Hotfix requires that Force Push be enabled in the WBMS GUI 
Connection settings in order to receive data in PDS. Refer to section 4.6.5 for more information on 
its functionality. 
 
General instructions are provided for integrating NORBIT sensors. For sensors not supplied by 
NORBIT, additional integration steps may be required which are not explained here. The setup 
examples used in this section assume that an iWBMS, iWBMSh, or iWBMSe was installed in a 
standard configuration. 
 
Note that the PDS sign convention uses Y+ Forward, X+ Starboard, and Z+ Up. This is not the 
same as the integrated Applanix systems on NORBIT sonars. Incorrect entry of the sign may corrupt 
data.   
 
The Applanix Ethernet groups required by PDS are automatically configured on integrated NORBIT 
systems, thus no action is required. The required groups are: 1, 3, 7, 10, 12, 20, 102, 

104, 111 and 113.  

 

 Offsets 

By default, integrated NORBIT systems output all sonar and navigation data at the WBMS Reference 
Point (refer to the Offsets section for more details). Therefore, PDS only requires the Sea Level 
offset, Center of Gravity offset, and LiDAR offset if the optional iLiDAR is installed. 
 
The Sea Level offset is used when depths are reduced using tide and heave. When RTK heights 
are used for depth reduction, the Sea Level offset is only used for applying the sound velocity profile 
at the correct depth. 

 
 

⚠ 

CAUTION:  For Integrated Systems, Sonar and INS Share Same Offset 

By default, integrated NORBIT systems output all sonar and navigation data 
at the WBMS Reference Point. Therefore, each device in the project setup 
should have the same offset. 

 
 

About the COR: The COR, for larger commercial vessels, is documented in the vessel design plans. 
For other vessels, this point at which the vessel’s roll and pitch axes intersect need to be determined. 
This is difficult to measure as the vessel CoR may change from day to day, and even during the day. 
Generally, choose a CoR location that is about ¾ distance from bow to stern, centered on the keel, 
and located at approximately water level. Especially for smaller vessels, the CoR moves depending 
on fuel stowage and even distribution of personnel body weight. For example, two persons sitting 
on the starboard rail of a 6m craft will move the CoR from the keel centerline a distance towards the 
starboard rail. Choose a location and attempt to keep the weight distribution constant throughout the 
survey. If in doubt, take the boat to open water and measure its motion while passing over waves in 
different directions. 
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 Setup Project 

Step 1. Create New Project and Setup Geodesy 
Create a new project in PDS Control Center via File > New Project. Specify a name for the project, 
and on the next page select a coordinate system from the geodatabase or define a new coordinate 
system according to the survey requirements. 
 

  
 
 

Step 2. Select Application Type and Run Configuration Wizard 
Select Multibeam Acquisition as the application type. Click Next and run the configuration wizard. 
 

  
 
 
 
 
 

 

 

 

 



 
 
 
 

 

10.4.3 User Manual                                       Contents April 17, 2020 
Firmware: 5.2.1   Page 102 of 142 

 

Step 3. Add New Vessel 
Specify a name for the configuration (e.g. “Survey Vessel Pole Mount”) and on the next page add a 
Local vessel which will contain all drivers and offsets. 
 

 
 

Step 4. Enter Offsets 
On the Geometry page, define the shape of the vessel (only for display) and enter the Center of 
Gravity offset as measured from the WBMS Reference Point. Leave the CoG Z field zero to keep 
the setup simple, as the Sea Level offset is defined in relation to the CoG. Then enter the Sea Level 
offset relative to the WBMS Reference Point. This should be a positive value. 
 
If the optional iLiDAR is installed, add its offset to the list. This is the measured offset from WBMS 
Reference Point to iLiDAR Reference Point. Refer to the iLiDAR manual for more details. 
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Step 5. Add Essential Devices 
Devices for each data type are added on the Equipment list. On the left side, select the Group and 
then select the driver to add. As a minimum, the following drivers are required: 
 

Group Driver I/O Port Offset 

Positioning system Geogs PosMV all coupled modes- ethernet msg 
3+10+12+20+102+104[pos] 

192.168.53.100 
UDP 5602 

Zero Offset 

Compass PosMV ethernet 3+102+104[hdg] 192.168.53.100 
UDP 5602 

Zero Offset 

VRU PosMV ethernet 3+102+104[vru] 192.168.53.100 
UDP 5602 

Zero Offset 

Multibeam NORBIT using RESON 7k protocol (1) 
[mbs] 

127.0.0.1 
TCP 7000 

Zero Offset 
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Step 6. Add Optional Devices 
Optional drivers may be added for snippets or side scan data, true heave data, and LiDAR data:  
 

Group Driver I/O Port Offset 

Snippets NORBIT using RESON 7k protocol (1) 
[snp] 

127.0.0.1 
TCP 7000 

Zero Offset 

Sidescan Sonar NORBIT using RESON-7k protocol (1) 
[sss] 

127.0.0.1 
TCP 7000 

Zero Offset 

Heave PosMV ethernet 3+111[heave] 192.168.53.100 
UDP 5602 

Zero Offset 

Laser Scan Velodyne LiDAR VLP-16[laser-scan] 192.168.53.101 
UDP 2368 

iLiDAR 

 
Step 7. Configure I/O Ports 

Select each device on the Equipment list and click I/O Port to configure the interfacing parameters, 
as per the tables in the previous sections.  
 

     
 
Step 8. Configure Device Properties and Apply Offsets 

For each device on the Equipment list, click Edit to open the Device Properties. Here you must select 
the offsets to apply, as defined previously on the Geometry setup. Recall that all applied offsets 
should be zero, except the optional iLiDAR. 
 

   
 
The patch test values, if known, may be entered in the device properties for the multibeam and 
optional iLiDAR. They should be entered in the Roll Correction, Pitch Correction, and Heading 
Correction fields. 

Applanix Devices Multibeam Devices iLiDAR 

Multibeam Properties iLiDAR Properties 
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Step 9. Configure Optional LiDAR Properties 
If the optional iLiDAR is installed, the orientation base must be set in device properties. This should 
be set to Down-Across assuming the scanner is installed in the standard configuration with 
connector aft. Refer to the PDS manual for more details. 
 

Step 10. Configure Height Source 
Select Reference Point Computation under the positioning device and double click, or press Edit. 
The height source can be set to GPS Height [RTZ] if RTK positioning is available, and if you wish 
for these heights to be used for depth reduction. Otherwise, set this to None. 
 
Height Standard Deviation Mask is a user-defined quality threshold for utilizing RTK heights in the 
depth calculation. By default, it is set to 0.1m, which means that the GPS Height source will only be 
applied if the altitude quality reported by the sensor is <0.1m. To ensure that RTK heights are always 
used regardless of reported quality, set the deviation mask to a high value, e.g. 10m. 
 

 
 

Step 11. Complete the Wizard 
Now the essential steps are complete. The next pages of the wizard contain optional setup steps, 
details of which are available in the PDS manual. Finish the wizard to return to PDS Control Center. 
To return to these settings and modify the vessel configuration, click the gear icon on the toolbar.  
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10.4 EIVA Setup for WBMS, iWBMS, iWBMSh & iWBMSe 

The WBMS GUI Version 10 Hotfix requires that Force Push be enabled in the WBMS GUI 
Connection settings in order to receive data in EIVA. Refer to section 4.6.5 for more information on 
its functionality. 
 
General instructions are provided for integrating NORBIT sensors in EIVA. For sensors not supplied 
by NORBIT, additional integration steps may be required which are not explained here. The setup 
examples used in this section assume that an iWBMS, iWBMSh, or iWBMSe was installed in a 
standard configuration. 
 
Note that the EIVA sign convention uses +Up. This is not the same as the integrated Applanix 
systems within NORBIT sonars. Incorrect entry of the sign may corrupt data.   
 
The Applanix Ethernet groups required by EIVA are automatically configured on integrated NORBIT 
systems, thus no action is required. The required groups are: 1, 3, 7, 10, 12, 20, 102, 

104, 111 and 113.  

 Offsets 

By default, integrated NORBIT systems output all sonar and navigation data at the WBMS Reference 
Point (refer to the Offsets section for more details). Therefore, each sensor in EIVA requires the 
same identical offset, that is the offset from Center of Rotation to WBMS Reference Point, assuming 
the CoR is chosen as the EIVA reference point. If the optional iLiDAR is installed, this offset must 
be separately measured and applied. 

 
 

⚠ 

CAUTION:  For Integrated Systems, Sonar and INS Share Same Offset 

Offsets from CoR are required if the INS is setup as recommended in this 
manual. Referencing data to the CoR reduces heave inaccuracies by 
replacing the heave data with attitude-induced lever arm corrections. 

 
 

About the COR: The COR, for larger commercial vessels, is documented in the vessel design plans. 
For other vessels, this point at which the vessel’s roll and pitch axes intersect need to be determined. 
This is difficult to measure as the vessel CoR may change from day to day, and even during the day. 
Generally, choose a CoR location that is about ¾ distance from bow to stern, centered on the keel, 
and located at approximately water level. Especially for smaller vessels, the CoR moves depending 
on fuel stowage and even distribution of personnel body weight. For example, two persons sitting 
on the starboard rail of a 6m craft will move the CoR from the keel centerline a distance towards the 
starboard rail. Choose a location and attempt to keep the weight distribution constant throughout the 
survey. If in doubt, take the boat to open water and measure its motion while passing over waves in 
different directions. 
 
This example configuration places the INS reference at the sonar reference, i.e. the INS was 
configured to output values to the sonar reference location. If users want to base bathymetric 
measurements referenced to the water level, the only other offset required is a water level correction. 
This allows application of tide station water level corrections if required. The water level correction 
involves translating the CoR up/down to the water level and confirmed by a bar check. 
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 NaviPac Setup 

NaviPac is required to perform a multibeam survey with EIVA. It is utilized by the helmsman display, 
and some additional information is shared with the online recording module, NaviScan. 
 
The configuration is performed via the NaviPac Configuration utility. Applanix POS MV is the only 
required device. Additional survey information may be configured here, but this guide only addresses 
the essential setup steps required to perform a survey. 
 

Step 1. Add Surface Navigation Instrument 
Under Instruments, right click Surface Navigation and add new item. Select POSMV Group 1 from 
the dropdown list. Enter the network communication parameters, as per below: 
 

 

 
 

 
 

Step 2. Add Gyro and Motion Instruments 
Add a Gyro instrument and select POSMV Gyro 102/3. For Motion, select POSMV RPH 102/3 
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 NaviScan Setup 

The next step involves adding sensors to NaviScan under the equipment, add sensor drop down 
menu. To integrate the Applanix INS with EIVA each function must be brought in separately.  
Therefore, a separate system must be installed for attitude, heading/gyro, and positioning.  
 

Step 3. Add Position Sensor 
Begin by adding the position sensor. Select position sensor and add Applanix POS MV and configure 
the network settings to IP address 192.168.53.100, on UDP port 5602. 
 

  
 

Step 4. Add Gyro Sensor and Motion Sensor 
Repeat the previous step to add the Gyro sensor and the Motion sensor. Under add sensor, select 
Gyro and Motion, respectively, and in each case choose the Applanix option. Configure the network 
settings as per the previous step. 
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Step 5. Add Echosounder 
To integrate the WBMS, go to Add Sensor and choose Echosounder. Select the Reson SeaBat 7k 
driver. In the port settings select TCP/IP Port, enable Local, and use port 7000.   
 

  
 

Step 6. Configure Max Beams 
Click on Reson SeaBat 7k under multibeam in the project tree. To the right of the project tree, under 
enter 256 for Max beams per scan. 

 

 
 

The final NaviScan project tree looks like the following:  
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Appendix A: Quick Start Guide 

Users are advised to refer to this section for a quick, basic installation guide without detailed 
descriptions of each operation. NORBIT recommends that users familiarize themselves with detailed 
descriptions of each operation/function before using this guide.  
 
WBMS sonar-only users should skip sections related to INS configurations. 
 

1. Unpack and Inspect: Unpack sonar system and inspect all cables and connectors for 
damage, dirt and moisture. Inspect the sonar for especially around the transducers for 
cuts or gouges.  

2. Sonar Installation: Depending on vessel being used, make an installation plan. Follow 
this plan to mount sonar (ideally with NORBIT bracket) on the vessel and align unit to be 
parallel with the vessel keel with the projector pointing aft. Bolt sonar bracket to pole with 
minimum of 4 bolts. Use lock-washers and/or LOC-TITE especially for longer duration 
setups as nuts will vibrate and loosen over time. Users are advised to connect wet-end 
sonar and IMU cables before mounting the system. This simplify the process of securing 
cables.  

3. Antennas: For GNSS/INS integrated WBMS: Mount GNSS antennas with 5/8” threaded 
bolts. While not necessary, it is helpful to align GNSS antennas to be parallel or 
perpendicular to vessel keel. The antenna closest to the WBMS is the primary. Select an 
antenna cable, label it at both ends (to prevent confusion) and use this to connect primary 
antenna to Ant1 on the SIU. Connect the secondary antenna to Ant2.  

4. Cables: Run cables from sonar and antennas to SIU. Avoid sharp bends and be cautious 
of chafing. Handle cables with care – rough handling will bend connector pins in the cables 
and lead to loss of signal. Do not run cables next to high voltage lines – spread cable out 
to avoid RF interference. 

5. SIU & PC: Connect the SIU to the control and acquisition PC via ethernet. Before 
powering the sonar set the IP address of the PC to 192.168.53.XXX where XXX can be 
any number from 101 to 255; set the subnet mask to 255.255.255.0  

6. RTK: If RTK is being used, set it up as needed. 
7. Offsets: For the default setup, measure offsets 

(green dotted line in image) from Top Center of 
Bracket to base of primary antenna (the antenna 
closest to the WBMS Reference Point).   

8. Power: Ensure power source is clean. Be aware of 
batteries that are under powered or cheap inverters. 

9. Software: On the control and acquisition PC, install 
the WBMS GUI version 10.4.0. For iWBMSc users, 
also install NovAtel Connect. With all hardware 
connected to the SIU, power it on and open WBMS 
10.4.0. On the Connection State tab wait until the 
Control Line, Firmware and Sonar Log turns green. 
Then click on Connection Dialog and select the 
correctly detected sonar and click Connect. Once 
connected, the GUI should start logging GNSS/IMU 
data automatically.  

10. INS Setup: In the GUI, navigate to INS Tools in the 
settings menu and open INS Setup Wizard. For the default and recommended setup, 
simply follow the prompts in the setup wizard and have the measured offsets, from top 
center of bracket to base of primary antenna, at hand. For the baseline vector, select 
Alignment Wizard. This way, the wizard will open automatically once the setup wizard is 
complete. The Alignment Wizard was known as the GAMS calibration in POSView. This 
process ensures agreement in the heading alignment between the GNSS and INS. For 
NovAtel users please refer to the NovAtel Setup information section of this manual for 
setup instructions.  
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11. Separate INS Software: Not applicable for iWBMSe, iWBMS & iWBMSh users running 
Applanix firmware >9.03 and sonar 10.4.0. Setup NovAtel Connect (Compact) or Applanix 
POSView (iWBMS). Enter in the measured offset to the primary antenna and separation 
distance to secondary antenna (POSView). Also enter the offsets from reference to CoR 
in the acquisition software. See below appendices. 

12. Acquisition: Setup the acquisition software of choice, e.g. HYPACK, QINSy, etc. Offsets 
to be with respect to the vessel center of rotation. The driver for the WBMS will be the 
RESON 7125 or 71xx. Newer software, the driver is called NORBIT. 

13. Tides: For verification that the INS system is ready for survey when using RTK, it is a 
good practice to use a time series graph of the tide values. As soon at the graph stabilizes 
on a narrow value range the system should be ready for survey.  

14. Bar Check: Run a bar check to validate sonar draft. 
15. Sound Speed: Verify the sound speed reported by the sensor on the sonar by comparing 

it to another sensor, e.g. a sound speed profiler.  
16. Patch Test: Run a patch test each time the sonar is installed or moved from its previous 

location. 
17. Have fun! 
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Appendix B: Advanced Applanix Setup 

While NORBIT has integrated many features of the Applanix into the NORBIT GUI, some features 
were not included to keep operation clean and simple. The features not included are typically used 
by a small subset of NORBIT users. If you require a feature that is not found inside the NORBIT GUI 
you may have to utilize POSView. If an item is not found within this section, please refer to the 
Applanix user guide.  
 
POSView can be used in conjunction with the NORBIT GUI. However, during INS setup in the 
NORBIT GUI, POSView must be in the monitor state and not in the connected state.  
 
 

⚠ 
CAUTION:  Use Correct POSView Version 

Do not use a POSView version that is incompatible with POS firmware 
installed on the sonar system. Doing so can cause unexpected errors in the 
POS MV system. 

 

Alternate COM port setup  

Some scenarios may require an alternate setup of 
the POS MV Com ports. Refer to the table below for 
guidance on handling some of these special 
scenarios. If a desired setting is not shown in the 
table below, contact NORBIT support for assistance. 

 

 

 

 

Scenario Solution 

A sensor in use requires heading in 
NMEA format. I am using an NTRIP 
service that required GPGGA 

Obtain a DB9 Y splitter.  
Set COM 3 to output a GPGGA string required by NTRIP and select 
a GPHDT string required by the device. Set the baud rate and the 
update rate to a setting required by the device.  
Use one side of the Y splitter to connect to the computer for NTRIP 
and connect the other end to device.  
*If the baud rate is set high enough there should be no issue in 
outputting any number of NEMA strings from the iWBMS 

A sensor in use requires the real-
time heave calculated at its position 
on the vessel and I am using base 
station broadcasting RTK correctors. 

Under, Lever Arms & Mounting Angles > Sensor Mounting, enter 
the XYZ offsets to the sensor in question.  
Under the COM 3 output select Binary and select the message string, 
and the device update rate. To the right of the update rate select 
Sensor 2.  
Under input, select Base 1 and select the type of correctors being 
used. 
Use a Y splitter to bring RTK corrections into the SIU and the Binary 
message to the desired device. In some applications a Null modem 
may be needed.  
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A sensor in use requires the real-
time heave calculated at its position 
on the vessel and I am using NTRIP 
for RTK correctors 

Follow the above steps for setting up the POS MV and set NTRIP 
service to a static position and input a position preferably located in 
the center of the survey area.  
 

I have a GPS receiver tied to my 
satellite corrector subscription 
service and need to bring it into the 
POS MV on the WBMS. 

Under Lever Arms & Mounting Angles > Sensor Mounting, enter 
the XYZ offsets to the auxiliary GPS receiver under the Ref to Aux 1 
GPS. Under Input & Output Configure COM 3 Input to AUX 1 GPS. 
This allows the POS MV to base its positions off the more accurate 
position obtained from the auxiliary GPS receiver 

 

Running Installation Calibration Control 

When offset measurements from the IMU sensing center to antenna phase center is not accurately 
measured or difficult to measure due to long measurement runs and around many bulkheads then 
it is possible to automatically calculate these offsets using POSView. This requires clear views to at 
least 6 GNSS satellites that are positioned in different orthogonal quadrants with at least one satellite 
(nearly) directly overhead and a strong RTK Fix positioning solution. Enter in the best measured 
offsets (determined from a mean of multiple calibrations) to the “Reference to Primary Antenna” in 
the Lever Arms window. 
 
 

⚠ 
CAUTION:  Installation Calibration Control Is Not Reliable 

Use of the Installation Calibration Control routine should only be used if 
physical offset measurements cannot be performed. The routine should be 
run a minimum of 3 times and values averaged. 

 
 
Go to Settings > Installation > Installation Calibration Control. This opens the dialogue window 
shown below. Select Reference to Primary GPS, then select Auto Calibration and OK. 
Immediately begin moving the vessel through tight figure-of-eight motions. The Figure of Merit will 
begin to count to 100 as solutions are determined. When complete, record the newly derived offsets 
on paper and run again. When the values remain steady to within 1cm, select Normal Transfer to 
copy these values to the Ref. To Primary GPS Lever Arm. Select Save Settings in the Settings 
pull-down. If the reference location in the POS MV is chosen to be a point other that the sensing 
center of the IMU, then apply the additional offsets to the derived values. Following this procedure, 
run a GAMS calibration.   

 

 

Applanix POS MV Nav Status 

Applanix POS MV v8.63 incorporates the following navigation status types. The Nav Status displays 
the source and quality of the GNSS sensors and the resulting mode of the navigation solution. These 
are listed below with those highlighted in green being the best solutions: 
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Nav Status Description 

DR (Dead 
Reckoning) 

No GNSS input is available; navigation is using only the IMU data 

RTCM DGNSS Navigator is tightly coupled using the primary GNSS raw observables plus base 
GNSS corrections (RTCM 1 or 9) 

CODE DGNSS Navigator is tightly coupled using the primary GNSS raw observables plus base 
GNSS corrections (RTCM 18 and 19, CMR, CMR+) 

FLOAT RTK Navigator is tightly coupled using the primary GNSS raw observables plus base 
GNSS corrections (RTCM 18 and 19, CMR, CMR+) 

FIXED RTK Same as Float RTK but better accuracy 

Pri. C/A Navigator is closely coupled using the primary GNSS position data in C/A mode 

Pri. DGNSS Navigator is closely coupled using the primary GNSS position data in DGNSS mode 

Pri. P Code Navigator is closely coupled using the primary GNSS position data in P-CODE mode 

Pri. FIXED /  
FLOAT RTK 

Navigator is closely coupled using the primary GNSS position data in RTK mode 

Aux. DGNSS Navigator is loosely coupled using the auxiliary GNSS position data in DGNSS mode 

Aux. P Code Navigator is loosely coupled using the auxiliary GNSS position data in P-CODE mode 

Aux. Float RTK Navigator is loosely coupled using the auxiliary GNSS position data in Float RTK 
mode 

Aux. WL RTK Navigator is loosely coupled using the auxiliary GNSS position data in Wide Lane 
RTK mode 

Aux. NL RTK Navigator is loosely coupled using the auxiliary GNSS position data in Narrow Lane 
RTK mode 

 

Decoupled IMU Mounting 

In some scenarios, it may be required that the IMU be decoupled from the sonar and mounted 
elsewhere on the survey vessel. This requires additional offsets that are not required for a typical 
iWBMS installation. Depending on the IMU mounting location, additional offsets may include IMU to 
vessel center of rotation (CoR) and CoR to sonar phase center. Should the user decide to use the 
IMU as the vessel reference then the IMU to CoR offset is not needed.  
 
To decouple the WBMS from the IMU start by removing the four bolts at the back of the iWBMS 
bracket. This should be done with the iWBMS resting on a padded surface to reduce the chances of 
damage. Once the 4 bolts are removed carefully separate the IMU from the sonar taking care to not 
lose the dowel nuts located in the base plate of the IMU.  
 
For mounting the IMU, NORBIT provides an optional mounting plate that mounts the IMU (shown in 
the appendix) in its NORBIT housing, with the connector facing towards the bow of the survey vessel. 
In this mounting configuration there is a +90° Z axis rotation.  
 
Should the user opt to mount the IMU without the optional NORBIT mounting plate the dowel nuts 
can be used. This requires that the IMU be secured to a mounting location that facilitates tightening 
the mounting screw from underneath. The utilized screws should be M6 and of an enough length to 
extend 23mm from the top of the mounting plate for securing the IMU.   
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In the decoupled mounting configuration, offsets from the IMU/CoR to WBMS Reference Point must 
be applied in the chosen acquisition software. If the 
IMU is at not the CoR/vessel reference point, the IMU 
offsets also must be measured and applied in the 
acquisition program. 

 
In the decoupled mounting configuration, the IMU 
offset should be measured from the vessel CoR to the 
center of the IMU fairing. The sensing center of the 
IMU is 0.08m below the top of the fairing. This value 
should be entered in Ref. to IMU Target. Offsets 
highlighted in red must be entered based on vessel 
offsets.  
 
Two cables are required if operating the system in a decoupled configuration: the standard split 
cable for the IMU and a separate WBMS cable for the sonar.  
 
For further information and assistance with this, please contact NORBIT support. Once POS starts 
receiving the Marinestar signal, the Nav Status will change to “Pri. Marinestar GPS” on the main 
POS MV display. 
  

Ref to Center of Rotation Lever Arm 

During surveys where RTK or PPK are not/cannot be utilized then the offset from WBMS Reference 
Point to vessel center of rotation should be entered to the Applanix POS MV. Applying these offset 
aids, the Applanix in properly computing both real-time heave as well as delayed heave. Extreme 
care must be taken when entering in these offsets as there is no way to correct incorrect offsets in 
post-processing. Failure to accurately enter the offsets results in incorrect heave calculation and 
degrades data quality.  
 
 

⚠ 
CAUTION:  Mistakes Cannot Be Fixed in Post-Processing 

Mistakes in Ref to CoR offsets cannot be fixed in post-processing. Extreme 
care must be taken when entering in offset values. Thoroughly review values 
prior to surveying 

 

Antenna Offsets 

The GNSS antennas below are the most common antennas found with NORBIT KITS. The        
measurements shown are from base of the antenna to its phase center.  
 
  

 
 
 
 
 
 
 

 
 
 

 

 

Trimble 540AP Antenna: 58mm (0.190ft)  Trimble 382AP Antenna: 66mm (0.217ft) 
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Appendix C: Sonar Hardware Dimensions 

C1. 12004 iWBMS / 12007 iWBMSh – Wet-end Dimensions (PN 24003-ACDB) 
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C2. 12004 iWBMS / 12007 iWBMSh 0.95°Tx Wet-end Dimensions (PN 24003-ABDB) 
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C3. 12005 iWBMSc / 12006 iWBMSe – Wet-end Dimensions – PN 24005/24018    
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C4. 12003 WBMS – Wet-end Dimensions (PN 24003-ACDB) 
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C5. 12003 WBMS with 0.95° Tx – Wet-end Dimensions (PN 24003-ABDB) 
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C6. WBMS Sonar Interface Unit (SIU) Dimensions (PN 29024) 
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Appendix D: Cable Pinout Diagrams 

D1. WBMS Sonar Interface Unit (SIU) Socket Pin Description (PN 29024) 
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D2. iWBMS Integrated Sonar Interface Unit (iSIU) Dimensions (PN 29028) 
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D3. iWBMS Integrated Sonar Interface Unit Socket Pin Description (PN 29028) 
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D4. WBMS Interface Cable Pin Description (PN 33029) 
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D5. WBMS Interface Cable Pin Description (PN 33075) 
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D6. WBMS Interface Cable Pin Description (PN 33029) 
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D7. WBMS Interface Pigtail Deepsea Cable Pin Description (PN 33095-x-Lx-D) 
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D8. iWBMS Split Cable Pin Description (PN 33129) 
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D9. WBMS Interface Pigtail Angled Pin Description (PN 33205) 
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D10. iWBMSc Interface Cable Pin Description (PN 33088) 
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D11. WBMS Bulkhead Pinout 
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D12. iWBMSe Bulkhead Pinout (PN 33169) 
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Appendix E: Mounting Bracket and Pole Dimensions 

E1. Decoupled IMU Mounting Bracket (PN 45654) 
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E2. Dual Head Bracket with iWBMSc / iWBMSe 
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E3. Dual Head Bracket with iWBMS / iWBMSh 
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E4. NORBIT Carbon Fiber PORTUS Pole 
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E5. NORBIT Mini Mount Outline with Laser Stand 
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E6. NORBIT Travel Mount 
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Notes 
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